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What are merlot’s applications? 

The merlot.aero suite is a complete organizational management solution offering all aspects of airline resource planning 

and control to ensure the safety, efficiency and quality of your crew and operational environment.  

 

merlot.aero is a comprehensive suite of applications covering all aspects of your airline needs. It has been developed 

with the entire business process in mind, including the customer process from the moment ticket sales are planned until 

the point the passenger reaches their destination. 

 

For your convenience, merlot applications are divided into two main categories: 

• Aircraft Applications 

• Crew Applications 

 

There are a number of applications under these two main categories.   

 

Aircraft applications include: 

• AircraftSchedule   

• AircraftFollow 

• AircraftPortal 

• AircraftMobile 

 

Crew applications include: 

• CrewPlan 

• CrewBuild  

• CrewRoster  

• CrewPortal 

• CrewMonitor  

• CrewFollow   

• CrewPayroll 

• CrewMobile  
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Introduction 

AircraftFollow provides a real time graphical representation of your airline's live status for the day. AircraftFollow allows the 

user to manage flight departures and arrivals and related operational tasks on a day-to-day basis. Reports on disruptions, 

such as late running aircraft, are available and the application provides accurate and timely information to improve the 

decision support process.   

 

AircraftFollow Prerequisites 

Prior to undertaking tasks in AircraftFollow, it is first necessary to define the route structure in the Configure application. In 

addition to routes, Configure is where you define turnaround times, ports, equipment types, delay codes and on time 

performance (OTP) parameters. Equipment registration takes place in Configure. See the Configure User Manual for more 

information.   

 

Tasks in AircraftSchedule take place before action in AircraftFollow. The user imports a Standard Schedules Information 

Manual (SSIM) or creates a new schedule. Once all the flights are in the schedule, the schedule is marked active. See the 

AircraftSchedule User Manual for more information. 

CrewFollow provides airlines with information to act on in response to crew disruptions resulting from (amongst other 

things) sickness, no shows and crew related disruptions on the day of departure. See the CrewFollow User Manual for 

more information. 
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Logging into AircraftFollow 

With your merlot.aero credentials, simply log in and select AircraftFollow. 
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The Graphical User Interface (GUI)  

The merlot.aero suite of applications eliminates the use of text commands by employing a Graphical User Interface 

(GUI). Let’s explore the AircraftFollow GUI: 

 

 
 

 
1. Tool Bar: Contains icons that give you access to commonly used AircraftFollow functions. 

2. Filter Panel: Set the criteria for the flights you want to monitor in the Flight Display Panel. 

3. Flight Display Panel: Displays real-time flight information in Grid, Gantt and Map view. 

4. Application Footer:  A non-interactive bar at the bottom of the Flight Display panel which contains information 

relating to open data in the Flight Display Panel. 

5. Flight Information Panel: Gives users access to all information related to a flight 

6. Violations Panel: displays relevant rules generated by the RulesEngine. 
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AircraftFollow Toolbar 

The AircraftFollow toolbar is located immediately below the menu bar.  

 
 

The toolbar contains icons which give users access to commonly used functions. An explanation of each icon is listed 

below.  

 

Icon Description   Icon   Description 

 

Open Flight Display 

 

  Delete Flight 

 

Save Flight Display Entries 

 

 Cancel Flight 

 

Print 

 

 Reinstate Flight 

 

Close Flight Entry Display 

 

 Divert Flight 

 

Add Flight 
 

 Ground Return 

 

Add Cycle 

 

 Air Return 

 

The practical application of frequently used AircraftFollow features is covered in the Addressing Irregular Operations 

section of this manual. 
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AircraftFollow Specific Tasks 

AircraftFollow tasks occur during the day-to-day operation of flights, after the 

flight schedule and crew rosters are finalized and published. This section 

provides an overview of AircraftFollow specific tasks in a step-by-step format. 

 

1. Filter flights for a specified date range and other flight criteria you 

want to monitor 

 

2. Manually input actual arrival and departure times, if applicable to your 

station. Also retime flights as needed.  
 

 

3. Monitor flights for irregularities such as early arrivals, late arrivals, 

irregular operations (IROP’s), diversions, delays in maintenance, etc. 
 

 

4. Take corrective action to address irregularities  
 

 

5. Ensure flights are legal on crew flight departure plans and duty rules. 

Communicate any anticipated flight departure plan issues to crew 

schedulers for early resolution in CrewFollow.   
 

 

6. Confirm flight information and flight log entries are correct and signed-

off 
 

 

7. Pull AircraftFollow specific reports as needed. These reports are 

found under the AircraftFollow Reports tab. 
 

 

 

 

 

 

 

 

 

 

Reports 

 

Confirm & Sign Off 
Flight Info & Flight Log 

Entries 

Ensure Flights Legal on 

Crew FDP & Duty Rules 

Take Corrective Action 

to Address Irregularities 

AircraftFollow Workflow 

 

Filter Flights to Monitor 

Manually Input Flight 

Times, if applicable 

 

Monitor Flights for 
Irregularities 
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Framework Applications 

The merlot.aero suite of applications eliminates the use of text commands by employing a Graphical User Interface (GUI). 

You are presented with the following options available in all applications across the merlot.aero suite. 

 

 
 

These are Framework Applications that will follow you throughout the merlot suite.   

 

This icon is the Job Engine .  If red, this means the job engine has stopped. If green, the job engine is running. 

 

 

This icon  is the signal strength of your connection to the Internet. 

 

The Memory Monitoring tool  displays memory utilization for merlot applications in real time.  

 

Memory utilization is displayed in three different levels: 

 

Icon Level Range 

 

 

 

Low (Green) 

 

 

0MB-700MB 

 

 

 

 

Moderate 

(Yellow) 

 

 

701MB - 1000MB 

 

 

 

 

High (Red) 

 

 

1001MB and above 

 

 

Hovering the mouse over the tool icon displays the following information: 

 

• Icon label - Memory Monitor 

• Memory consumption in MB with KB conversion e.g. 64 MB (65660 KB) 

• Level of memory consumption e.g. Low 
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This icon is Ad Hoc Reports . Ad hoc reports are available in all the applications and modules across the merlot.aero 

suite while specific application reports are available in the Reports dropdown menu. 

 

 

 
 

This icon is the Shift Log .  You can add notes to the Shift Log for any system user to view. 

 

 
  

This icon is to Add Task .  Set a daily or one-time reminder for everyday activities (i.e.: Accommodation Check). 

 

 

This is the send documents  icon. Send a document to a crew member or to a fellow merlot.aero user.   
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This is the mail  icon.  Send messages to crew or co-workers via SMS, email or directly within the merlot.aero 

suite. 

 

 

This icon allows you to navigate through the entire merlot.aero suite. 

 
 

When the application setting UseUIDebug is set to True, the New Activity Log menu will be visible under the Login Centre 

and available for use. All incoming Merlot UI Error Logs will not be displayed in the existing error log in the application nor 

trigger the alert unless the error is related to Insert/ Add/ Delete rows. 
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Example of a collapsed Activity Log form: 

 

 
 

When a user expands the log value, the complete details of the selected UI error log will be displayed. 

 

Example of an expanded Activity Log form: 
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AircraftFollow Panels 

This section provides users with an overview of merlot.aero application panel functionality to carryout AircraftFollow tasks 

detailed later in this manual. The panels that are reviewed include the Filter Panel and Flight Display Panel, in addition to 

AircraftFollow application icons located in the toolbar. 

Filter Panel 

The purpose of the Filter Panel is to define the set of flights that will be displayed within the Flight Display Panel. To view 

flight data in the Flight Display Panel, users must specify search data in the Filter Panel.   
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The Filters for the Flight Display Panel can be divided in the following sub-sections: 

 

• Date and Time  

• Filter Management  

• Standard Criteria  

• Advanced Criteria 

• View the Data 

 

Date and Time  

To view flight data in the Flight Display Panel, users must load the data for a specified date range. Dropdown calendar 

controls are provided to select the dates. Time is selected using the up/down arrows.  

 

Users can also type the date and time into the following fields: 

 

• From: - Date and time fields. The start value of the date/time range that the data must start at or after 

• To: - Date and time fields. The end value of the date/time range that the data must end by or before 

 

Note: The date controls throughout the merlot suite have built-in shortcuts. These shortcuts allow users to instantly select 

different date targets, such as the current day (T), or the start of a month (M), a quarter (Q) or a year (Y).  

Filter Management  

To manage filters, you can choose an existing filter, save criteria for future use or delete a saved filter that is no longer 

needed. 

 
• Saved Filters - Select a saved filter from the dropdown menu  

• New Filter - Name your new filter                             

Click the Save to save a new filter or select the filter that is no longer needed from the dropdown menu under Saved Filters. 

Click Delete.  

 

A confirmation is required before deletion is considered final. 

Standard Criteria  

The Standard Criteria filter section contains the following criteria which are used to determine which data is displayed in 

the Flight Display Panel. 

 

Field Description 

Designator Displays airline designator codes. If a carrier has more than one airline in their group, the menu 

shows all active airline codes. 

 

Note: Designator and operator codes and ports can display either IATA or ICAO codes. By default, 

IATA codes are used. If your company requires using the ICAO codes, please contact Customer 

Support. 

Operator Displays airline operator codes. If a carrier has more than one airline operator certificate, the menu 

shows all active operator codes. 
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Field Description 

Equip Type Displays the active aircraft type(s). 

Equip Rego Displays the active aircraft registration(s) or tail numbers. 

Route Displays the airline’s active routes. 

Hub Displays the available hubs (ports). 

Status Displays the status of flights that can be filtered. Currently, only active flights can be selected. 

 

Note: Leaving a field blank in any filter panel includes all options for that field. 

Advanced Criteria  

This section is optional. 

 

Aircraft on Ground - Enter the number of minutes that represents the threshold of an aircraft on the ground. For 

example, if you enter 120, aircraft that will not fly in the next 120 minutes will be displayed.   

Flight Status Criteria  

Field Description 

Active Flights When selected, the Flight Display Panel will display all active flights. If deselected, the 
options to the right will be enabled and disrupted flights will be displayed. 

All Disrupted 
Flights 

Displays all delayed/diverted flights 

Delayed Flights Displays all delayed flights 

Diverted Flights Displays diverted flights 

Deleted Flights Displays deleted flights 

Cancelled Flights Displays cancelled flights 

AR/GR Displays air returned and ground returned flights 

Refresh Data Reloads the current flight selection to display data that could have been changed by other 
users 

 

View and Reset  

• Reset Button: Clears the selected filter criteria except for date and times selected. 
• View Button: Displays flights based on the filter criteria in the Flight Display Panel. 
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Other 

Maintenance: When selected, maintenance events will be displayed in the Flight Display Panel. 
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Flight Display Panel   

The Flight Display Panel displays real-time flight information for flights defined by the user in the Filter Panel. The Flight 

Display Panel enables airline operations personnel to monitor flight operations in real-time and to respond quickly to 

operational irregularities by making necessary adjustments to aircraft and crew.  

 

The Flight Display Panel consists of three views: 

• Grid – displays flight information in a tabular layout 

• Gantt – Gantt chart view of flight information 

• Map –  displays real-time aircraft location and flight path through an integration with FlightAware. 

Grid View 

The grid view displays flight information in a tabular layout which facilitates efficient manipulation of flight information. Each 

row in the Grid represents one flight and each row expands to display a sub row containing additional information.  

 

 
 

The time fields in the Grid can be configured to display different text colors when flights are on time, have an estimated 

delay, a minor delay, a major delay or when the flight is cancelled or deleted. For instance, on time or early flights may be 

displayed in green, possible delays in orange, and delayed or cancelled flights in red text. The flight color scheme is 

determined by the client in Configure. 

The column headers in the Flight Display Panel Grid view include the following: 

 

Column Description 

Equip Aircraft type 

Rego or Tail 
Number 

Aircraft registration number. The option to call it Rego or Tail Number is controlled by the user 
preference ShowTailNumber 

Flight* Flight number 

Suffix 
The operational suffix of the flight. Used only if a flight is diverted or returned to the original 
airport 

Desn* Designator 
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Column Description 

Date Date of the flight 

Route Type Domestic, International or as defined in Configure 

Route Flight route (departure-arrival) 

STD  Scheduled time of departure 

ETD  Estimated time of departure 

ATD  Actual time of departure 

STA  Scheduled time of arrival 

ETA  Estimated time of arrival 

ATA  Actual time of arrival 

Total Delay Total delay minutes 

 

 
 

Onward Flight Indicates the next flight number in the flight sequence 

Cycle Number The cycle number is a particular cycle in a series of flights on specific day. It represents the 
flight sequence to be given to an aircraft. 

Icons Indicators for additional information for the flight are collected here. Icons will be discussed in a 
later section. 

Turn Around Time value difference between the flight’s arrival and its next departure 

Operator Selected airline carrier  

FIW Icon  This icon opens the detailed Flight Information Window (FIW) 

EquipConfig 
Equipment type configuration for the aircraft. 
Each equipment type can have more than one configuration for seats and cargo.  

Operator Displays the airline operator for the flight. 

 

Note: The column order can be reorganized according to user preferences under the FieldPosition preference group. 

Expanded Row in Flight Display Panel  

 

Each row in the grid can be expanded to provide users with additional information about the flight, as well as to provide 

access to data fields with information such as passenger counts, delay breakdowns and flight status codes. 
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By clicking the plus (+) button at the left end of a row in the Flight Display grid, the row expands and the user can view 

additional information such as the flight status, delays and notes. Additionally, the red links provide access to editable data 

fields which are described in the Flight Information Window (FIW) section of this manual. 

 

Users have a quick and easy way to add Out/Off and On/In times (OOOI) by entering the applicable values using the 

expanded row feature of the Flight Display Grid, as shown above. OOOI times are another term for off chocks, take off, 

landing and on chocks. 

Right Click Features  

 
Additional features are available to the user in the grid view, by right clicking on a selected row. 

 

The following options are available from the right click menu:   

Option Description 

Print Display Allows users to print information displayed in the Flight Display Panel 

Add selected to 
PlayPen 

Allows user to add selected flights to the PlayPen view to try out options before saving. This will 
be available in the future. 

Get Manifest Data Queues manifest data from a third party system. Data is displayed in the Manifest tab. This 
feature requires development and/or configuration prior to becoming active. Please contact 
Customer Support for assistance. 

Get Pax Number Queues passenger numbers from a third party system. Data is displayed in the Flight 
Information Window (FIW). This feature requires development and/or configuration prior to 
becoming active. Please contact Customer Support for assistance. 

Get OOOI Queues Out, Off, On and In (OOOI) times from a third party system. This feature requires 
development and/or configuration prior to becoming active. Please contact Customer Support 
for assistance. 

Get Flight Position Queues Get Flight Position from an external provider. This data can be seen in the Flight 
Information Window (FIW). This feature requires development and/or configuration prior to 
becoming active. Please contact Customer Support for assistance. 
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Flight Information Icons  

 

These icons are displayed in the Icons column if it applies to a flight. Each one is described below. 

 

Icon Icon Name Description 

 

Flight Comment The Flight Comment icon is displayed if there are flight comments for the flight.   

 

Divert Flight The Divert Flight icon is displayed if the flight has been diverted from the 
scheduled route. 

 

Ground Return The Ground Return icon is displayed if the flight returns to the departure gate or 
bay without taking off. 

 

Air Return The Air Return icon is displayed if the flight returns to the departure gate or bay 
after taking off. 

 

Curfew Violation The Curfew Violation icon is displayed if the flight departs or arrives in a port 
within a curfew period. 

 

Aircraft 
Registration 
Allocation Conflict 

The Aircraft Registration Allocation Conflict icon appears if you allocate the 
registration to a flight that has applicable restrictions/conflicts. 
 

 

Flight Log Entered The Flight Log Entered icon is displayed if a flight log or voyage report has been 
entered for the flight.  

 

Aircraft 
Registration with 
Below Minimum 
Scheduled Turn 
Around Conflict 

The Aircraft Registration with Below Minimum Scheduled Turn Around Conflict 
displays when there is not enough turnaround time between flights. Turnaround 
times are set in Configure. 

 

Minimum 
Equipment Listing 
(MEL) 

The Minimum Equipment Listing (MEL) icon will display if the aircraft has a MEL 
against it.  

 

Non-Standard 
Flight Times 
Conflict 

Each route has a standard flight time set up in Configure. If the standard flight 
time is not followed, the Non-Standard Flight Times Conflict icon will display. 

 

Maintenance 
Conflict 

The Maintenance Conflict icon appears when a flight overlaps with a 
maintenance event. 

 

Port/Route 
Restriction Exists 
 

If there are requirements for certain ports and routes, the Port/Route Restrictions 
Exists icon alerts the system user to the restrictions. This will be available in a 
future release. 

 

Flight is Flagged 
 

The Flight is Flagged icon displays when a flight has a flag entered. The flag will 
also display in AircraftPortal. This can be used as a signal between users in the 
main office and the outstations. 

 

Air to Ground 
Reporting 

The Air to Ground Reporting icon is displayed when flight updates are sent from 
the aircraft to the ground via ACARS/AFIRS. This can be set up by selecting Air 
to Ground for the aircraft in the Equipment > Registration page of Configure. 
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Icon Icon Name Description 

 

Info about Missing 
Data is shown 

Actual departure and arrival times have not been entered for flights that have 
departed/arrived. 

 

Assignment 
Property 

The pairing associated to this flight has an assignment property. 

 

Gantt View 

To access the Gantt view of flight information, click on the Gantt tab in the Flight Display Panel. 

 

 
 

The Gantt view presents flight information graphically in a Gantt or bar chart format. The zoom level of the Gantt can also 

be manipulated by holding the Ctrl key and dragging the timeline header left or right. 

 

Flights are displayed as rectangular objects, or pucks, which are aligned along a horizontal axis called the cycle line. The 

Gantt view is an effective way of representing flight sequences and is more efficient for managing issues such as aircraft 

routings or recovery from disruptions. 

 

The Gantt view has several sections: 

• Zoom and expansion 

• Equipment and Cycle 

• Gantt chart 

 

Zoom and Expansion 

 

The Zoom and Expansion section is right below the Grid and Gantt tabs. This allows the user to modify the view of the 

Gantt chart. 
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The buttons and links are described below: 

 

Button Description 

 

Zoom in and Zoom out  

Zoom in extends the Gantt chart to a wider view. Zoom out condenses 
the Gantt chart to a narrower view. 

 

Scroll left and Scroll right  

Moves the Gantt chart left or right, depending on the clicked button  

Preset view 

 

Clicking any of these links sets the view to display flights within the 
selected range. For example, if 6 Hours is selected and the current 
view starts at 08:00, flights from 08:00 to 14:00 are displayed.  

Print  
Prints out the current Gantt view 

Expand/ Collapse Cycles

 

Expands or collapses all the cycles in the Gantt view to display or hide 
information on each flight. Expanded cycles reveal a middle row for a 
flight puck, which is discussed in a later section. Alternatively, click the 
[+] beside the equipment type of a cycle to expand it, and click [-] to 
collapse. 

 

Equipment and Cycle 

 

When the Equip column is expanded the following layers are displayed: 

 
A. Un-Allocated – All cycles with no registration assigned 

B. Allocated –  All cycles with registration assigned  

C. Available – All active aircraft which are not assigned to a cycle  

 
 

If there are no flights within that layer, the layer is not displayed. Within each layer, cycles are grouped by equipment type. 

If there are no flights under a certain equipment type, the layer for the equipment type is not displayed. 

 

The View > Gantt Sort Options allows a user to sort cycles by Departure Time, Departure Port and Registration/Tail. Sorting 

by Registration/Tail is not applicable to the Un-allocated section; however, this section can be sorted by departure time. 

When Departure Time is selected and two cycles have the same departure time for their first flights, the two cycles are 

arranged by departure port. When Departure Port is selected and two cycles have the same departure port for their first 

flights, the two cycles are arranged by departure time. 
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The Cycle drop-down menu enables users to assign regos/tails to a series of flights within the Allocation Gantt. Aircraft 

Registration entries will be displayed in white, followed by details of the aircraft’s last flight prior to the filter start date in 

orange. 

 

Example: 
9VTAE 

320 TR2664 TRZ -1:15 [3] 

The drop-down list can be sorted in a First In First Out order list. The list consists of the following details: 

 

 
 

Element Description 

Aircraft Equipment Type Displays the equipment type. Example: 320 

Designator and Flight 
Number 

Displays the flight designator and flight number. Example: TR2952 

Arrival port Displays the arrival port of the last flight assigned to the registration. Example: SZX 

Turnaround time 
Displays the remaining time between last flight in aircraft and earliest flight in the filtered 

view. Example: 1:00 

Turnaround days 
Displays the number of turnaround days. If turnaround time is 36 hours, the turnaround 
time and day will be presented as 12:00(+1) 

Suitability Indicator 

The Suitability Indicator displays the following: 

 

• Green double up arrows if a match exists between the equipment type and 

the arrival port of last flight and departure port of first flight match. 

• Yellow up and down arrows if the equipment type does not match, but the 

arrival port of last flight and the departure port of first flight match. 

• Red double down arrows if the ports do not match. 
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Gantt Chart 

 

The Gantt chart displays all flights that result from the filter. All flights follow the timeline at the top. Each time the timeline 

moves, the flights move along with it. A red line that crosses from the timeline to the application footer shows the current 

time. 

 

The flight, also known as a sector, leg or puck, contains summarized details along with a number of graphical elements 

designed to provide users with useful information at a glance. The cycle line on which the flight sits also contains a collection 

of data and graphical elements which relate to the flight sequence rather than the specific sectors on the line.  

Flight Puck Details 

 

(Reading left to right and top to bottom) 

Data Element Description 

Departure port The departure port of the flight. (NKG) 

Departure time Time of departure or off chocks. This displays the STD, ETD, or ATD of the flight, whichever 
is available. The time is appended with A for actual and E for estimated. (17:09A) 

Flight number Flight number (181) 

Arrival Time Time of arrival or on chocks. This displays the STA, ETA or ATA of the flight, whichever is 
available. The time is appended with A for actual and E for estimated. (22:47A) 

Arrival Port The arrival port of the flight. If the flight returns or is diverted, the arrival port is updated. (SIN) 

Total Departure 
Delay Minutes 

These are the total number of departure delay minutes associated with the flight. If this is 
blank, there is no delay. This can also display the number of minutes the flight departed early. 
(9) 

Total Passenger 
Numbers 

Represents the total number of passengers in all classes on the flight. (315) 

Total Arrival Delay 
Minutes 

These are the total number of arrival delay minutes associated with the flight. If this is blank, 
there is no delay. This can also display the number of minutes the flight arrived early. (17) 

Flight Status Bar A color indicator at the bottom of each puck indicates if a flight is on time, has a minor or major 
delay or if it is a future flight.  
 
The color on the left side corresponds to departure details, while the color on the right 
corresponds to arrival details.  
 

 
 
The default colors for each are green, yellow, red and gray.  
 
Note: These colors can be changed in the user preferences in Configure. 
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Data Element Description 

On Time  
 

Minor Delay  
 

Major Delay  
 

Future Flight  

 

Other Gantt Symbols 

 

The flight below has an interchanging symbol of a clock and a question mark at the right edge. This signifies that it has 

been more than 10 minutes since the flight’s departure time and no updates have been made to the flight. 

 

 
 

The flight below is airborne, meaning it has OUT and OFF times entered. Users can see that there is an airplane symbol 

beside the flight number to signify that. 

 

 
 

The flights below have a red circle with an exclamation point inside. This signifies a conflict. For this example, it is a port 

turnaround conflict. It means that flight 182’s arrival port does not match flight 128’s departure port, which makes it 

impossible for the aircraft to operate both flights. Other conflicts include insufficient turnaround time (not enough time 

between two flights) and curfews (flight cannot depart or arrive at the airport during that time). 

 

 
 

Right Click Features  

 
Additional features are available to the user in the Gantt view by right clicking on a selected row. 
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The following options are available from the drop-down menu. Click on the flight before clicking the right click button.   

Option Description 

Show Crew Displays the Assigned Crew form, which has a list of operating and deadheading crew 
assigned to the flight. 

Get Manifest Retrieves a flight manifest of the flight from a third-party system. 

Get Pax Number Retrieves the passenger numbers of the flight from a third-party system. 

Get OOOI Retrieves the flight movement times (out, off, on and in times) from a third-party system. 

Get Flight Position Retrieves the aircraft’s current position to display in the map. This will be available in a future 
release. 

Show Crew 
Connections  

Connects the flight to the next flight/s that crew have to board next. This is discussed further 
below. 

 

Crew Connection Indicator 

 

The Crew Connection Indicators are visual cues that enables flight operation users to quickly visualize crew pairings in the 

Gantt, predict potential disruption, as well as allow all users to visualize connecting flights. The illustrations below show 

the different scenarios where the crew connection indicator is most useful.  

 

For the first image, it shows the basic crew connection where the crew’s pairings are on the same aircraft. 

 

 
 

The following illustration shows the changes in cycles where the crew pairings are on different aircraft. 

 

 
 

The default colors are blue for the pilots/tech crew and red for the cabin Crew. These can be changed in Configure by 

updating the value of the user preferences CrewConnectionsTechCrewColour and CrewConnectionsCabinCrewColour. 
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Pop Up Menu 

 

The intuitive popup menu enables you to conveniently move, join, swap and drop flights in the Gantt by dragging a flight 

puck and holding the mouse on left-click. The floating tool menu displays in the upper-right-hand side where you released 

the cursor. 

 

 
 

The following options will be displayed: 

 

Icon Name Hotkey Description 

 

 

Swap 

 

W 

 

Swaps a flight with the target flight. 

 

 

Swap 

Onward 

Flights 

 

Shift+W 

 

Swaps a flight with the target flight, including all 

the following flights on both cycles. 

 

 

Join 

 

A 

 

Joins a flight to another cycle. 

 

 

 

Join 

Onward 

Flights 

 

Shift+A 

 

Joins a flight with the target flight, including all the 

following flights. 

 

 

Replace 

 

S 

 

Replaces a flight with the target flight and drops 

the target flight into a new cycle. 

 

 

Replace 

Onward 

Flights 

 

Shift+S 

 

Replaces a flight with the target flight and drops 

the target flight into a new cycle, including all the 

following flights on both cycles. 
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Move 

 

D 

 

Moves a flight from one cycle to another. 

 

 

Split 

Cycles 

 

X 

 

Splits a cycle into two, starting from the selected 

flight. 

 

Hovering the cursor over an icon in the popup menu displays a tooltip with the icon name along with its assigned hotkey. 

 

 
 

Button options are enabled depending on how you utilize the functionality. The following table explains the basic 

functionality of the popup menu icons: 

 

Icon Function 

Swap Enabled only when a flight puck is released on top of another flight. 

Swap + Following Flights Enabled only when a flight puck is released on top of another flight. 

Join Enabled only when a flight puck is released on top of another flight puck 

which is the last flight in its cycle 

Join + Following Flights Enabled only when the selected flight is NOT the last flight in a cycle and 

the flight puck is released on top of another flight puck which is the last 

flight in its cycle. 

Replace Enabled only when a flight puck is released on top of another flight. 

Replace + Following 

Flights 

Enabled only when a flight puck is released on top of another flight. 

Move Enabled only when a flight puck is released into an empty space. 

Split Cycles Enabled whenever the selected flight is NOT the first flight in the cycle. 

(It is not possible to split an entire cycle from itself) 

 

Whenever an icon is selected or a hotkey is pressed, the system automatically runs the following two new rules together 

with the standard aircraft ruleset.  

 

• Flight Port Mismatch Rule – This rule checks for port mismatches; and 

• Flight Turnaround Time Rule –This rule checks for minimum turnaround time between flights. 

Below are some sample scenarios on how to utilize the popup menu. 

 

1. Sample scenario for Swap  
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User clicks and drags Flight 9211 onto Flight 9205 and performs a swap operation. 

 

 
 

Flight 9211 is moved to Cycle 1 and now follows Flight 9204. 

 

Flight 9205 is moved to Cycle 2 and now follows Flight 9210. 

 

 
 

 

If Swap + Following Flights  is selected, all onward flights will follow Flight 9211. 

 

 

2. Sample scenario for Replace  

 
 

User clicks and drags Flight 9211 onto Flight 9205 and performs a replace operation. 

 

 
 

Flight 9211 is moved to Cycle 1 and now follows Flight 9204. 
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Flight 9205 is moved on to a new cycle. 

 

 
 

 

If Replace + Following Flights  is selected, all onward flights will follow Flight 9211. 

 

 

3. Sample scenario for Move  

 
 

User moves Flight 9211 to the empty space after Flight 9210 and performs a move operation. 

 

 
 

Flight 9211 is moved onto Cycle 2 and now follows Flight 9210. 

 

 
 

 

4. Sample scenario for Split Cycle  
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User clicks and drags Flight 9211 outside its original cycle line and performs a split cycle operation. 

 

 
 

Flight 9211 is moved to a new cycle.  

 

 
 

Confirmation for Onward Flight is no longer required for cycle changes. 

 

5. Sample scenario for Join  

 
 

User clicks and drags Flight 332 outside its original cycle line and performs a join operation. 

 
 

Flight 332 is now joined with Flight 321. 
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If Join + Following Flights   is selected, all onward flights will follow Flight 332. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



2016 | COMMERCIAL IN CONFIDENCE | Page: 38 of 121 

Map View 

The Flight Position Map feature displays real-time aircraft location and flight path through an integration with FlightAware. 

 

Current positions and information such as flight number, aircraft type, route, position, ground speed, altitude, ETA, flight 

crew, passengers, baggage, cargo for all active aircrafts can be accessed in the Map tab. The ShowMapTab user 

preference which controls the display of the tab is defaulted to TRUE. This means that the tab is automatically displayed 

when AircraftFollow is accessed. 

 

The aerial view map is initially set to a zoom level of 10 and users can click and drag the map around.  

 

Note: The Map tab can be detached and restored from the panel and can be maximized to cover the whole space of the 

browser. 

 

Active ports are marked with yellow pins and employee bases are marked with red pins. 

 

 
 

The map refresh interval is dependent on your airline setting. It is initially refreshed every 5 minutes. 

 

Airborne aircrafts are in green if on time, yellow if with minor departure delay, and red if with major departure delay. 

Flight paths are displayed by clicking on the aircraft and the path from departure to arrival port will be drawn. 
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On Time Flight 

 

 
 

Minor Delay 

 

 
 

Major Delay 
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Displaying Map Details 

 

The following flight information are displayed when a user hovers the mouse over an aircraft icon.  
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Flight Information Panel 

The Flight Information panel gives users access to all information related to a flight. Users can also edit flight information 

from this window and the panel can be docked anywhere in the screen and works best when extended to a secondary 

monitor. 

 

 

 
 

The panel is divided into sections. The layout of the fields are as follows: 

 

Field Description 

Date Date of flight. 

Flight Flight number. 

Operator Operator code of the flight. 

Total Pax Total number of passengers. 

Route Departure and arrival ports. 

Route Type Classification of the route. Usual options are domestic and international. 

Rego Name Aircraft registration or tail number. 

Equip Aircraft model or equipment type 

STD/STA Scheduled Time of Departure (STD), Scheduled Time of Arrival (STA) . 
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Field Description 

ETD/ETA Estimated Time of Departure (ETD), Estimated Time of Arrival (ETA). 

ADT/ATA Actual Time of Departure (ATD), Actual Time of Arrival (ATA). 

Flight Time Flight time from aircraft takeoff to aircraft on the ground. 

Total Delay Total delay minutes. 

Onward Onward flight or connecting flight. 

Seat Config Configuration of seats for the aircraft. 

Equip Config Specific configuration of selected equipment type. 

Service Type Type of service for the flight i.e. Passenger – Normal service, Cargo, Ferry, etc. 

Client 
Reference 

Reference to client name, used mainly for charter flights. 

Contract 
Number 

Reference to a contract for the flight, usually for charter flights. The list of contract numbers 
depends on the selected client reference. 

Status Status of flight in the system. Set to Active by default. 

 

Other Times 

The Other Times link launches the Flight Follow Time window which allows users to add and delete aircraft times i.e. Doors 

Closed, Out from Gate, Wheels Up, and In to Gate. The OOOI times seen in the Grid have corresponding fields in this 

form. 
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More Options  

When the More Options link is accessed, the following additional options related to the flight displays: 
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Additional Flight Information 

 

The Additional Flight Information window displays flight information displayed in the Flight Information panel. This is also 

displayed in More Options > Times. 

 

 
 

Counters 

 

The Flight Follow Counter Group window allows users to add and delete default counter groups i.e. baggage, cargo, freight, 

mail, other and passengers for a flight.  
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To update counter groups, click on Add to add a new row, enter the Code, Description, Unit of Measure and select Active 

and click Save.  

 

Unit of Measure 

 

The Unit of Measure window displays active and inactive units of measurements used for counter groups. 

 

 
 

Times 

 

The Flight Follow Time window allows users to add and delete aircraft times i.e. Doors Closed, Out from Gate, Wheels Up, 

and In to Gate. The OOOI times seen in the Grid have corresponding fields in this form. 

 

Flight times added in the Flight Follow Time form will update 

actual departure and arrival times in the Grid.   

To update flight times, click on Add to add a new row, select 

the item being updated from the Name drop-down menu, then 

enter the time value and click Save.  
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Status 

The Flight Follow Status window allows users to track the status of the flight from a passenger perspective. Values entered 

into this form can be transferred to flight information display systems (FIDS) via the merlot.aero web service. A visual of 

the Flight Follow Status form is located under the View menu section of this manual. 

 

 

Delays 

The View and Add Delay Minutes Breakdown window allows users to track and edit the delays incurred by a flight. This 

form can be set to automatically display when a departure or arrival time is entered and a delay is detected. This behavior 

is controlled by user preferences in Configure. 

 

Above the grid are the flight number, aircraft registration or tail number and the remaining delay minutes that are not 

associated with delay codes. The columns are described below. 

 

Column Description 

Delay Minutes Number of delay minutes with the corresponding reason for delay. 

Delay Type Type of delay. Options are Departure Delay, Arrival Delay and Consequential Delay. 
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Column Description 

Original Flight If Consequential Delay is the selected delay type, the flight number that originally caused the 
delay can be entered here. Otherwise, select N/A. 

Delay Code Group Correlates with the delay code. This is the category of delay reasons. Once a delay code 
group is selected, the list of delay codes available will be filtered down to the delay codes for 
the selected delay code group. 

Delay Code Correlates with the delay code group. Displays a list of reasons for the delay. 

Note: Delay code groups and delay codes are preset in Configure. 

Delay Comments Free text field where users can add some details on the delay. 

Created On Date of creation for the delay record. 

If the previously entered delay information is contested, users can still modify the necessary details in this form as long as 

the flight log has not been signed off for this flight yet.   

Logs 

 

The Log Details window allows users to update flight logs associated to a flight. A flight log must be logged to display this 

window. Details on flight logs are discussed in a later section. 

 

 

Messages 

 

The Flight Follow Messages window allows users to add and delete messages pertaining to a flight. To add messages, 

click Add to add a new row, enter your flight comment in the Comment column and click Save. The Updated By and 

Updated Date/Time columns will automatically populate with user information and a date/time stamp. 

 

Messages entered by outstation users in AircraftPortal can be viewed here as well. 

 

 

Requirements 

 

The Flight Requirement window allows users to add and delete flight requirements such as wheelchairs.  
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To update Requirements, click Add to insert a new row and enter the flight requirements in the Requirements column. The 

remaining columns automatically populate with user name and a date/time stamp. Click Save then click Cancel to close 

the window and return to the Flight Information Window. 

 

This information will display in the Special Service Request (SSR) area in AircraftPortal. 

Flags 

 

The Flight Follow Flag window allows users to add an informational flag against a flight. For instance, a flight may be 

flagged to show that there is a VIP on board.  

 

 

 

To update the window, click Add to insert a new row, indicate flag number using the up/down arrows in the Flag column, 

enter comments in the Comment column.   The remaining columns automatically populate with user name and a date/time 

stamp. Click Save to save your information and then click Cancel to close the form and return to the Flight Information 

Window.  

History 

 

The History window enables users to view the changes made to a flight. It records the date and time of the change, the 

description of the change (update or insert), the user who made the change, the field that was changed, and the old and 

new values. All the information in this form are read-only. 
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Complement Delta 

 

The Complement Delta window allows the user to adjust the required crew complement for the associated flight leg. 

If the complement needs to be adjusted (i.e., 2 CPT, 0 FO), click the Add button, select the rank from the Rank drop-down 

menu and enter the number to be added or lessen in the Complement column. When finished, click Save to save the newly 

updated information followed by Cancel to return to the Flight Information Window. 

 

 

Known As 

 

The KnownAs window allows users to name a flight, such as a training flight for crew. This form is also used to list the 

designator and flight number for code sharing flights. The same process used to update FIW forms is used to update the 

Flight Follow Known As form. 
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Restrictions 

 

The Flight Restrictions window allows users to view equipment and port restrictions affecting a flight.  

 

 

Flight Position 

The Get Flight Position window allows users to determine where an aircraft is in terms of latitude and longitude and what 

its heading, speed and altitude are at a given time. The user can print this information. This feature requires development 

and integration prior to activation.   

 

Market Pair 

The Market Pair window allows users to view the number of passengers who have connecting flights on the arrival port 

and who have the arrival port as their destination. The numbers can be specified to show how many passengers are 

booked with the airline and how many passengers are booked on a code share flight. A print option is available. This 

feature requires development and integration prior to activation. 
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Port Requirement  

The Port Requirement Equipment window allows users to view, add and delete equipment requirements at a specified 

port. The default set up for port requirements takes place in Configure.    

 

To add a port requirement, click Add to insert a new row, choose Must Have, Must Not Have or No Condition from the 

Condition column. Select the Equipment Profile from the dropdown menu. Select the applicable dates from the drop-down 

calendars if different from the auto populated dates. Choose the applicable rule level from Rule Level selections. Add any 

comments and check the Active check box to indicate an active port requirement.  Finally, click Save. 

Crew 

 

The Assigned Crew window shows the names of all crew members currently assigned to a flight as well as their previous 

and next flights. Employee Details which contains vital information such as the legality of a crew flying on a specific flight 

route can be accessed in the Assigned Crew window. System users can add crew members and other employees 

(engineers, ground staff, etc.) to the flight and/or send messages to the crew. This feature also allows users to select if the 

employee will be included in the GenDec report, APIS messages, Voyage Report and Briefing report.   
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To display Employee Details in Assigned Crew window: 

 
1. Double-click the name of the crew. 

The Employee Details window will be displayed. 

 

 
 

Note: The buttons that will be displayed below the Employee Details window depends on your assigned security 

access. 

 

2. Proceed by doing either of the following: 

a. If you have permission to modify employee record, update the necessary details then click Save. 

b. If you don’t have access to modify employee record, press X located on the upper right corner of the 

window. 

Route Requirement 

The Route Requirement Equipment form allows users to view, add and delete equipment requirements at a specified 

port. The default set up for port requirements takes place in Configure.    

 

 

To add a port requirement, click Add to insert a new row, choose Must Have, Must Not Have or No Condition from the 

Condition column. Select the Equipment Profile from the dropdown menu. Select the applicable dates from the dropdown 

calendars if different from the auto populated dates. Choose the applicable rule level from Rule Level selections. Add any 

comments and check the Active check box to indicate an active port requirement.  Finally, click Save. 
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Violations Panel 

The Violations Panel displays relevant rules generated by the RulesEngine. 

 

 
 

The panel consists of the following columns: 

 

Field Description 

Severity/Violation 
icon 

Displays violation icons which helps users to determine the severity of a violation at a glance. 

Date Displays the date of the violation. 

Rego Displays the Rego of the flight that with the violation. 

Flight Displays the flight number of the flight that with the violation. 

Object Displays the type of flight entity affected by the violation, i.e. port, route, flight, employee. 

Error Type Displays the rule name being violated. 

Description Displays the description of the violation. 

 

When the user right-clicks on any of the violations listed within the Violation Panel, the standard violations right-click 

menu option will be displayed. This panel works the same way as the Violations panel in the crew applications. 
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Users can proceed by selecting one of the following: 

 

• Toggle Show All 

• Re-evaluate violations 

• Clear All Violations 

• Print 

Supported Aircraft Rules  

The following Aircraft rules are part of the existing client rule set, and will be available in Configure > Rules > Rules 

Configuration menu. 

 

• Flight Route Time Variation Rule 

• Flight Time Logic Rule 

• Restriction Rules  

• Flight Duty Period Rules 

Flight Display Panel Application Footer 

The Application Footer is a fixed non-interactive bar at the bottom of the Flight Display Panel which contains information 

relating to all the flights on display, including on time performance (OTP) figures and operational statistics.   

 
 

The Application Footer fields are as follows: (Using the sample application footer displayed above)  

Field Description 

# Total number of flights in view in the Flight Display Panel, in this example 38 flights 

First   First scheduled departure flight, in this example 0:45 am 

Airline OTP On Time Performance (OTP) for flight departures (D), arrivals (A), turn around (T), expressed in 
percentages (%) for all the airline’s flights for the selected date range 

Filter OTP On Time Performance (OTP) for flight departures (D), arrivals (A), turn around (T), expressed in 
percentages (%) for flights that are filtered for the view  

Last Last scheduled arrival of the day, in this example 3:30  

 

Data in the application footer is based on delay and OTP information set up in Configure. 
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Assigning Registrations 

 

Users can assign aircraft registrations to a flight or series of flights through the following: 

 

• Grid – when assigning regos using the Grid view, click on the drop-down menu located in the Rego column, select 

a registration then click Save Flight Display Entries located in the toolbar to save changes.  
 

 
 

• Gantt – when assigning regos using the Grid view, click on the drop-down menu located in the Cycles column, 

select a registration, then click Save Flight Display Entries located in the toolbar to save changes. 

 
 

Registration assignment is based on the date range of the flights loaded into AircraftFollow.  
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A pin located at the left side of each equipment type allows users to isolate some aircraft on top of the Gantt. This is helpful 

when working on disruptions or reassigning flights to other aircraft.  

 

Click the pin to isolate the aircraft and click it again to remove it from the top.  
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Update Flight Departure and Arrival Times 

The AircraftFollow Flight Display Panel enables users to quickly enter and update flight departure and arrival times. This 

section will discuss the methods and guidelines for updating times.   

 

If Aircraft Communication Addressing and Reporting System (ACARS) is used by an airline to transmit flight time updates, 

then any information entered by a user be overwritten via ACARS. After ACARS messages are received and processed 

by the JobEngine, the user can override what was entered by ACARS. 

 

Flight departure times can be updated in the Grid and Gantt view of the Flight Display Panel. The process of updating time 

in the grid is discussed below. 

 

Change Estimated Time of Departure 

When an estimated time of departure (ETD) is updated, and the ETD is earlier than the scheduled time of departure (STD), 

or the previous ETD, several options are provided to the user and the effects of each option are discussed below. In the 

snapshot below, the flight’s STD is 10:55 and the new ETD is 10:50.  

 

1. Adjust the ETA and update subsequent flights 
• The system updates the estimated time of arrival (ETA) based on the configured route time (i.e., ETA = ETD 

+ route time).   

• The system updates the ETD and ETA of subsequent flights only where they have previously been delayed.  

• Flights are updated sequentially until the STD is obtained and/or the excess time has been absorbed. Any 

existing delay minutes stored against a subsequent flight are reduced based on the Default Delay Removal 

Preference setting.  

 

2. Adjust the ETA of this flight only 
• The system updates the ETA based on the configured route time (i.e.: ETA = ETD + route time).  This option 

does not impact subsequent flights. 

 

3. Accept and continue as entered 
• The system does not update the ETA. This option does not impact subsequent flights. 

 Choose an applicable option and click OK, or click Cancel to close the dialog box without generating action. 
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When an ETD is updated, and the ETD is later than the STD or the previous ETD, several options are provided to the user 

and the effects of each option are discussed below. In the snapshot below, the flight’s STD is 10:55 and the new ETD is 

11:00. 

 

1. Adjust the ETA and update subsequent flights to maintain route times and operational turnarounds. 
• The system updates the ETA based on the configured route time (i.e., ETA = ETD+ route time).   

• The system updates the ETD and ETA of subsequent flights based on the route times in order to maintain 

operational minimum turnarounds.   

• Turnarounds are reduced to the minimum operational turnaround before the next flight in the sequence is 

delayed.   

• Flights are updated sequentially until a change is no longer required to absorb the initial timing change.  

• Any delay minutes for subsequent flights should be automatically populated or removed as consequential 

delays related to the initial flight (if Use Consequential Delays is selected in the delay settings).  

 

2. Adjust the ETA for this flight only (subsequent flights will require manual adjustment) 
• The system updates the ETA to the value.  

• If no route time value exists the user must update the ETA with the STA value.   

• This option does not impact subsequent flights.   

• Any minimum turnaround issues or flight overlaps will be alerted to the users as a Flight Conflict icon and 

the conflict details will be populated in the Flight Conflict window. Since subsequent flights are not being 

updated in this option, no consequential delays will be added to subsequent flights. 

 

3. Accept and manually enter new ETA  

• It should be noted that subsequent flights will require manual adjustment. 

• The system prompts the user for a new ETA time. The prompt form field defaults to the value. However, if 

no route time exists it defaults to the STA time.  

• This option does not impact subsequent flights.   

• Any minimum turnaround issues or flight overlaps will be alerted to the users as a Flight Conflict icon and a 

flight conflict will be populated in the Flight Conflict window. Since subsequent flights are not being updated 

in this option no consequential delays will be added to subsequent flights. 

 

4. Accept and continue as entered.  

• As with points 2 & 3 above subsequent flights will require manual adjustment 

• The system accepts the ETD as entered and does not update the ETA or populate it with the STA if no value 

exists.   

• This option does not impact subsequent flights.   

• Since subsequent flights are not being updated in this option no consequential delays will be added to 

subsequent flights. 

Choose an applicable option and click OK, or click Cancel to close the dialog box without generating action. 



2016 | COMMERCIAL IN CONFIDENCE | Page: 59 of 121 

Change Actual Time of Departure 

The time change process for actual times is similar to that used for estimate times. The primary exception is that users will 

be prompted to enter delay information if the Enforce Delay Entry setting is enabled. 

Change Estimated Time of Arrival 

When an estimated time of arrival (ETA) is updated, and the ETA is earlier than the scheduled time of arrival (STA), or the 

previous ETA, several options are provided to the user and the effects of each option are discussed below. In the snapshot 

below, the flight’s STA is 13:29 and the new ETA is 13:20. 

 

 

1. Accept and update subsequent flights to maintain route times and operational turnarounds 
• The system updates the ETD and ETA of subsequent flights only where they have previously been delayed.  

• Flights are updated sequentially until the STD time is obtained and/or the excess timing value has been 
absorbed.   

• Any existing delay minutes stored against a subsequent flight are reduced based on the Default Delay 
Removal Preference setting.  
 

2. Accept and continue as entered (subsequent flights will require manual adjustment) 
• The system completes the action with the entered ETA.  

• This option does not impact subsequent flights. 

Choose an applicable option and click OK, or click Cancel to close the dialog box without generating action. 
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When an ETA is updated, and the ETA is later than the STA or the previous ETA, several options are provided to the user 

and the effects of each option are discussed below. In the snapshot below, the flight’s STA is 12:24 and the new ETA is 

12:50. 

 

1. Accept and update subsequent flights  
• The system updates the ETD and ETA of subsequent flights based on the route times in order to maintain 

operational minimum turnarounds.  

• Turnaround times are reduced to the minimum before the next flight in the sequence is delayed.   

• Flights are updated sequentially until a change is no longer required to absorb the initial timing change. 

• Any delay minutes for the subsequent flights should be automatically populated, or removed, as consequential 
delays related to the initial flight if Use Consequential Delays is selected in the delay settings. 
 

2. Accept and continue as entered (subsequent flights will require manual adjustment) 
• The system accepts the ETA and completes the operation.   

• This option does not impact subsequent flights.  

• Since subsequent flights are not being updated in this option, no consequential delays will be added to subsequent 
flights. 

Choose an applicable option and click OK, or click Cancel to close the dialog box without generating action. 

Change Actual Time of Arrival 

As above, the time change process for actual arrival times is the same as that used for estimate arrival times. 
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Addressing Irregular Operations 

This section addresses irregular operations using the merlot AircraftFollow application. Instances covered include adding 

flights and cycles as well as canceling, deleting, reinstating and diverting flights. Ground returns, air returns and swapping 

flights are also detailed. 

Adding Cycles 

A cycle is a series of linked fights that are/will be assigned to an aircraft. These flights are linked by onward flights. Once 

cycles are created, new flights can be added to the cycle by using the Add Flights icon. 

 

 
 

1. Click the Add Cycle  icon to create a cycle.  

2. A new row will display at the bottom of the Grid. 

3. Enter the details of the flight. 

4. Click the Save Flight Display Entries  button. 

Creating a New Flight 

1. Click the Add Flight  button and a new row will be added to the grid at the bottom of the display. If a flight 

was selected before clicking the Add Flight button, the new flight will be linked to the previously selected flight 

and both flights will be in the same cycle. 

 

2. Manually enter the details of the flight by clicking on a field and selecting an option from the list or typing the data. 

Required fields are annotated in the heading with an asterisk.  

3. Click the Save Flight Display Entries  icon to save the newly added flight. 

Cancelling a Flight 

1. In the Flight Display Panel Grid or Gantt view, select the flight to be cancelled. 

2. Click on the Cancel Flight  icon.  
3. You will be asked to enter a reason for the cancellation.   
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4. A confirmation message will display if the cancelled flight has an onward flight that will result to a port mismatch. 
Click OK to close the dialog box or Cancel to close the dialog box without generating action. 
 

 
 

5. Click the Save Flight Display Entries  icon to save the changes. 
 

Once cancelled, all fields of the cancelled flight are disabled. The onward flight number is removed and the flight times are 

shown in grey. Additionally, the cancelled icon is displayed in the Icons field. Moreover, if a subsequent flight is affected 

by the cancellation, a message is displayed to the user and a Flight Conflict icon placed on the flight.   

 

 
 

In the Gantt view, the flight is removed from the Gantt display. 

 

 
 

Cancelled flights can be reinstated and may be included in the on-time performance (OTP) statistics depending on the 

OTP configuration in Configure. 

 

Deleting a Flight  

Flights that no longer need to be operated or mistakenly created can be deleted instead of cancelled to avoid including the 

flight in the cancellation statistics. 

 

1. In the Flight Display Panel Grid or Gantt view, select a flight and click on the Delete Flight  icon.  
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2. When a flight is deleted, the user is asked to provide a reason for the deletion.   

 

 
 

3. A confirmation message will display if the cancelled flight has an onward flight that will result to a port mismatch. 

Click OK to close the dialog box or Cancel to close the dialog box without generating action. 

 

 
 

4. Click OK to confirm deletion.  Click Cancel to close the form without generating action. 

Once deleted, all fields of the deleted flight are disabled and the onward flight number is removed and the flight 
times are shown in gray. Additionally, the Delete icon is displayed in the Icons field. Deleted flights are removed 
from the flight schedule and OTP statistics. 

 

Reinstating a Flight 

A cancelled or deleted flight can be reinstated to bring it back to an active state.  

 
1. In the Flight Display Panel Grid or Gantt view, select a flight.  

2. Click on the Reinstate Flight  icon. 

3. Provide a reason for reinstating the flight. 
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4. Click OK to close the dialog box with the reason for flight reinstatement or click Cancel to close the dialog box 

without generating action. 

The selected flight will be reinstated in a new flight sequence without an onward flight.  

 

Diverting a Flight  

1. In the Flight Display Panel Grid or Gantt view, select the flight to be diverted.  

2. Click on the Divert Flight  icon.  
3. Enter the new port, updated ETA and reason for the diversion. The port drop-down list displays all active ports. 

A prompt for the route time will appear if the new route does not have it set up yet.    

 
 

4. Click OK to confirm the diverted flight.  Click Cancel to close the form without generating action. Upon 
commitment of the values in the form the application will initiate the divert flight process. 

 

What happens next includes the following: 

 

• The route is updated based upon the new arrival port 

• The ETA is updated based upon the entered value 

• The onward flight is removed and a Flight Conflict icon is placed in the Icon field of the subsequent flight due to 

port mismatch 

• The Divert icon is placed in the Icon field 

 
Note: The route of a flight can be changed from the Grid view only if the flight is in the future. This action does not 
constitute a diversion. STD, STA, ETD and ETA need to be manually adjusted. 
 
 
 



2016 | COMMERCIAL IN CONFIDENCE | Page: 65 of 121 

Ground Return 

A ground return occurs when an aircraft pushes back from the gate to prepare for takeoff, but returns to the gate for 

whatever reason.  

1. Ensure that the ATD and OUT times are in place. 

2. In the Flight Display Panel Grid or Gantt view, select the flight that is returning to the gate or bay.  

3. Click on the Ground Return  icon.  

4. Fill out the necessary fields. All the fields are described below. 

 
 

 

 

Field Description 

Original Flight Flight number of the ground returned flight 

Return ETA  Enter the revised ETA 

Return ATA Optional: Enter the ATA, if already available 

Reason Enter a reason for the ground return 

Create a new instance of this 

flight 

If selected, a new instance of the original flight will be created. This will allow 

the airline to continue with the flight as planned but with a delay due to the 

ground return 

Revised Original Flight Number If selected, a different flight number will be used to continue with the trip 

Operational Suffix 

If selected, the original flight number will be used and a suffix of G will be added 

to distinguish this from the continuing flight. The suffix can be changed with 

another letter. 

New ETD ETD of the continuing flight 
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Field Description 

New ETA ETA of the continuing flight 

Delay subsequent flight to 

preserve minimum operational 

turnaround time 

When selected, the onward flight will be delayed with the minimum turnaround 

time after the continuing flight. Do not select this if the subsequent flights will be 

reassigned to another aircraft. 

Keep delay with original flight 
If selected, the delay code and minutes will be recorded against the ground 

returned flight. Otherwise, it will be recorded against the continuing flight. 

Use the same crew on the new 

instance 

If selected, the same crew will operate the continuing flight. If this goes beyond 

the allowed crew hours, violations will be raised in CrewFollow and 

CrewMonitor. If not selected, crew scheduling will be warned to assign crew to 

the continuing flight. This will be available in a future release. 

 
5. Click Insert Ground Return to insert the ground return, or click Cancel to close the form without generating 

action. 

The results are dependent on options selected in the Ground Options form.  

• The arrival port and times, flight designator and onward flight value of the original flight are updated based upon 

the values entered. 

• The Ground Return icon is placed in the Icon field of the original flight. 

 

If the user has selected to create a new flight instance:   

• A new flight instance with the same flight label as the original flight will be inserted in the grid using the new 

ETD/ETA provided and the STD and STA of the original sector. The onward flight value will be populated with the 

initial value from the original flight thereby preserving the flight sequence. 

• The system will insert a consequential departure record against the new flight instance for the total delay incurred 

by the ground return event. 

 

If the user has selected not to create a new instance: 

• The system will finalize the transaction and insert a Flight Conflict icon in the Icon field due to the port mismatch. 

• If the user has selected to retain delays against the original flight the system will keep a copy of the delay, and its 

reason, against the original sector. 

• If the user has selected to delay subsequent flights, the system will delay the subsequent flights after the new 

flight, reducing subsequent turnarounds to the minimum until the delay has been absorbed. This amount will be 

recorded as a consequential delay based on the original flight. 

 

In the Gantt view, a ground return is affected by selecting the flight object followed by the Ground Return icon. The same 

process is followed as described for the Flight Display Panel grid view with the following exceptions: 

• A Ground Return icon is placed in the sector object of the original flight. 

• The new flight sector object is placed after the puck of the original updated sector. 

• If the user has selected not to create a new instance, the system will finalize the transaction and insert a Flight 

Conflict icon in the Icon field due to the port mismatch. 

 

 

Air Return 
 

When an aircraft has taken off from a port but has to return to the same port, it is called an air return.  The air return process 

updates the selected flight and inserts a new flight after the one selected.   

 

1. Ensure that the OUT and OFF times of the flight are in place. 

2. In the Flight Display Panel Grid or Gantt view, select the airborne flight that needs to return to gate or bay. 

3. Click the Air Return  icon.  

 

The air return process follows the same steps as the ground return process cited above. Once the air return has been 

applied, the air return icon is displayed in the Icons field in the Grid view. 
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Manipulating Flights  

To Swap, Join, Replace, Move or Split Cycle, refer to the Pop Up Menu. 
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Maintenance Events 

Aircraft maintenance is the overhaul, inspection, modification or repair of an aircraft or a component of an aircraft. 

Maintenance may include the installation or removal of a component from an aircraft. 

 

Aircraft maintenance checks are periodic inspections that have to be done on all commercial/civil aircraft after a certain 

amount of time or usage. Military aircraft normally follow specific maintenance programs which may be or not similar to the 

commercial/civil operators.  

 

Maintenance events can be managed from the Manage Maintenance option under the Tools menu. 

 

 
 

Find Maintenance Event 

To find a maintenance event using the search function in the Manage Maintenance form: 

 

1. Select applicable Operator, Equipment Type and Equipment Rego (Tail Number) from the dropdown menus. 

2. Select the Start Date and End Date from the drop-down calendars to define a period for the search criteria. 

3. Select Planned if only planned maintenance events will be searched. 

4. Click on the Fetch button. 

 

A list of the selected aircraft’s maintenance events will display in a user selectable form. This list will only 

display the maintenance events that fall within the date range selected. 

 
 

5. If no further action is required, click Cancel to close the form without generating action. 
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Maintenance Template 

There are different maintenance tasks that each aircraft requires depending on the need. For example, daily checks could 

take 1-2 hours and an A Check could take at least 4 hours. These maintenance types must be set up before adding 

maintenance events. To add maintenance templates: 

 
1. Click the Add New Maintenance Event button at the bottom of the Manage Maintenance form. 

2. Click the Maintenance Template link at the top right corner of the form. 

 
 

3. Click the Add button and fill out the fields. 

Field Description 

Description Type of maintenance to be performed 

Equipment type Aircraft model 

Duration How much time is required for this maintenance type 

Max Hours Maximum number of hours of flying allowed before this maintenance type is required 

Max Cycles Maximum number of cycles of flights allowed before this maintenance type is required 

Comments Free text field for additional notes 

Text Color Text color of the maintenance event to be displayed in Grid and Gantt 

Background Color Background color of the maintenance event to be displayed in Grid and Gantt 

Bottom Color Bottom color of the maintenance event to be displayed in Gantt 

 
4. Click Save to commit the changes, or Cancel to discard the changes.  

Add Maintenance Event 

To add a new maintenance event from the Manage Maintenance form: 

 

1. Click the Add New Maintenance Event button at the bottom of the Manage Maintenance form. 
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2. Complete all the fields. 
 

 
 

Field Description 

Maintenance 
Event Type 

Select the maintenance type to be performed. If the required maintenance type is not available, 
click the Maintenance Template link. Refer to the previous section for instructions. 

Operator If there are more than one AOCs for your airline, select the correct operator code. Otherwise, 
this field is optional. 

Equipment Rego Select the equipment registration or tail number from the dropdown list 

Equipment Type Automatically populated based on the selected rego 

Start Date Select the start date for the maintenance event from the dropdown calendar  

End Date Select the end date for the maintenance event from the dropdown calendar 

Start Time Enter start time in hh:mm format. The time mode of the application (Local or Zulu) will be 
followed. 

End Time Enter end time in hh:mm format. The time mode of the application (Local or Zulu) will be 
followed. 

Max Hours Max hours declared for this maintenance type in the maintenance template (see Maintenance 
Template)  

Max Cycles Max cycles declared for this maintenance type in the maintenance template (see Maintenance 
Template) 

Title Title of the maintenance event. This defaults to the maintenance event type selected. 

Location Location where the maintenance will be done, for example a hangar or ramp 

Duration Automatically calculated based on the start and end times 

Route 
Restrictions 

If applicable, select the check box to apply route restrictions 
 

Port Restrictions If applicable, select the check box to apply port restrictions 

Port Select the port where maintenance will be applied 

Status By default, maintenance events are Planned. Set this to Active if this is available for all users to 
view. This scheme follows the activation of flight schedules in AircraftSchedule.  

Comments Enter any comments for users and station managers’ information 
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3. Click Save to save the event or Cancel to close the form without generating action.  
 
Maintenance events are displayed in the Grid as such: 

 

 
 

Maintenance events are displayed in the Gantt as below: 

 

 
 

Edit Maintenance Event 

To edit an existing maintenance event from the Manage Maintenance form: 

 

1. Select the desired maintenance event in the grid. 

2. Click on Edit selected maintenance event button at the bottom of the Manage Maintenance form 
3. The system will open the same Edit Maintenance form similar to Add Maintenance Events (see previous  

section). 
4. Apply the required changes. 

5. Click Save to save the changes or the Revert Changes to discard modifications or Cancel to close the form 

without generating action.  
 

The Edit Maintenance form can also be accessed by double clicking on the maintenance event in the Gantt view. 

 

Delete Maintenance Event  

To delete an existing maintenance event from the Manage Maintenance form: 

 

1. Select the desired maintenance event in the table. 

2. Click Delete maintenance event at the bottom of the Manage Maintenance form. 

3. Click Save to save changes or Cancel to close the form without generating action. 
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Flight Logs 

Flight logs are the official records of a flight. The information from these logs is entered in AircraftFollow under Manage 

Flight Logs in the Tools menu. 

 

Flight logs are the basis for take-off and landing currency. Pilots have currency requirements that must be met in order for 

them to be legal to operate. For instance, a port may need to be operated into and/or out of a certain number of times 

within a specified time period in order for the pilot to remain current. Likewise, a route may need to be operated a certain 

number of times within a specified time period in order for a pilot to remain current on the route. Instrument flying, day and 

night flying, and landing currencies can be recorded on flight logs.  

 

To access flight logs, select the Tools menu and choose Flight Logs then select Manage Flight Logs.    

 

 
 

It is important to note that the flight logs form is the final entry point for all flight information. Once a flight log is signed off, 

flight information cannot be changed anymore. By clicking SignOff, you are certifying that the information in the flight log 

is correct.   

 

There are two sub-sections of the Flight Logs form. The first section (upper part) of the form contains a filter to search for 

the flight logs and the second section (lower part) contains the flight logs.   

Find Flight Logs 

The search criteria include the following fields: 

 

Field Description 

Operator  Select operator from the dropdown menu 

Equip Type Select the equipment type/s  

Equip Rego Select the aircraft registration or tail number from the dropdown menu 

FlightNo Enter the flight numbers to search for. Each flight number must be separated by a comma 

From Enter the start of the date range to search from 

To Enter the end of the date range to search from 

Suppliers Select the suppliers included in the flight logs being searched for 

Routes Select the routes included in the flight logs being searched for 

 

 

Click Find to search. Results will be displayed below the filter. Once the flight log has been located, it can be updated and 

signed off as required. 
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Flight Log Contents 

This section discusses each section of a flight log starting from the flight log header, which can be seen as search results. 

As seen from the image above, each flight log has the following main columns: 

 

Field Description 

Equip Equipment type of the inclusive flights 

Registration Aircraft registration or tail number 

Date Date of the inclusive flights 

Log No Flight number populated by the system 

Flights Comma-delimited list of flights included in the flight log 

Created At Date and time when the flight log was created 

Last Updated Date and time when the flight log was last updated 

Updated By Name of the user who last updated the flight log 

Signed Off At Date and time when the flight log was signed off 

Signed Off By Name of the user who signed off on the flight log 

 

From the search results above, click the [+] at the leftmost column to expand the contents of a flight log. Several tabs will 

be displayed and each of them are discussed in the next sections. 

 

 
 

FlightInfo 
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FlightInfo is the first tab of a flight log. It contains basic flight information. The columns are described below. 

 

Field Description 

Date Date of the flight  

Flight Flight number 

Route Actual route 

STD Scheduled time of departure. Time mode follows that of the application 

STA Scheduled time of arrival. Time mode follows that of the application 

Block (Optional) Standard block time based on aircraft registration setup in Configure 

Out / Off blocks / 

Out from Gate 

Time of push back from gate/bay. The label of this column can be modified in the Time Code 

page of Configure. 

Taxi (Optional) Total taxi time. The label of this column can be modified in the Time Code page of 

Configure. 

Off / Take off / 

Wheels up 

Airborne time. The label of this column can be modified in the Time Code page of Configure. 

On / Land / 

Wheels down 

Landing time. The label of this column can be modified in the Time Code page of Configure. 

In / On blocks / 

In to Gate 

On chocks time. The label of this column can be modified in the Time Code page of Configure. 

Actual block time Total block time for the flight or the difference between In and Out times 

Air time Total flight time for the flight or the difference between On and Off times 

Delay time Delay minutes per flight. If the value is negative, it means the flight departed earlier than 

scheduled. 

Delay codes Delay codes associated with the delay minutes. 

Operation type If the aircraft returned to gate, indicate if the aircraft had a ground return or air return 

Service type Type of service for the flight i.e. Passenger – Normal service, Cargo, Ferry, etc. 

Remarks Comments regarding the flight 

 

Tech Crew 

 
 

The Tech Crew tab contains some information regarding the pilots assigned to the flight. 

 

Field Description 

Date Date of the flight  

Flight Flight number 

Route Actual route 

Employee Employee ID 

Name Employee name 

Position Employee position 

Rank Employee rank, for example CPT or FO 

Seats Seat for the flight, for example LHS or RHS or jump seat  

Roles Role for the flight, for example Operating or Deadheading 
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The next columns may or may not be displayed in your flight log as these are configurable. Some of these flying and 

approach types may not be needed for tracking by your airline. 

 

Field Description 

AI AI 

INST Instructor 

LD Landing 

NH Night Hours 

NL Night Landing 

NT Night Takeoff 

TO Takeoff 

DGA DGA is Distance Measuring Equipment or Global Positioning Satellite System Arrival 

GNSS Global Navigation Satellite System 

GPS Global Positioning System 

ILS Instrument Landing System 

LLZ Localizer 

MIL MIL 

MLS Microwave Landing System 

ND Navigation Display 

NDB Non-directional radio beacon 

PRA Pre-recorded announcement 

TC Type certificate 

VA Design Manoeuvring Speed or Heading to an Altitude 

VD Design Diving Speed or Heading to a DME distance 

VN VN 

VOR VHF Omni-directional range and ranging  

 

Cabin Crew 

 
 

The Cabin Crew tab contains some information regarding the cabin crew assigned to the flight. 

 

Field Description 

Date Date of the flight  

Flight Flight number 

Route Actual route 

Employee Employee ID 

Name Employee name 
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Position Employee position 

Rank Employee rank, for example CC or SFA 

Seats Seat for the flight, for example jump seat  

Roles Role for the flight, for example Operating or Deadheading 

 

 

Fuel  

The Fuel tab catalogs the distribution and use of fuel for each flight. 

 

Field Description 

Date Date of the flight  

Flight Flight number 

Route Actual route 

 

The next columns may or may not be displayed in your flight log as these are configurable. Some of these fuel 

records may not be needed for tracking by your airline. 

 

Previous Fuel from previous flight 

Uplift Amount of fuel loaded into the aircraft 

Engine Run Fuel used on engine run 

Departures Amount of fuel prior to departure 

Brakes Release Amount of fuel before brakes are released 

Planned Burn Planned consumption of fuel 

Average Fuel 

Burn 

Average amount of fuel burned for the aircraft 

Arrival Amount of fuel upon arrival 

Remaining Remaining fuel 

Ground Run Distance travelled on ground without using the engine 

Gauge Run Fuel used for gauge run 

Actual Fuel Burn Actual consumption of fuel 

Suppliers List of fuel suppliers 

Dockets Tickets for referencing loaded fuel 

Units Unit of measure for loaded fuel 

 

Oil 

The Oil tab catalogs details pertaining to oil consumption. 
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Field Description 

Date Date of the flight  

Flight Flight number 

Route Actual route 

Uplift E1 (Ltr) Amount of oil loaded in engine 1  

Uplift E2 (Ltr) Amount of oil loaded in engine 2  

Uplift E3 (Ltr) Amount of oil loaded in engine 3  

Uplift E4 (Ltr) Amount of oil loaded in engine 4  

APU Amount of oil loaded in the auxiliary power unit 

 

Trend 

 

The Trend tab is designed to contain information on consumption patterns for all flights. This will be available in the 

future. 

Pax/Cargo 

 

The Pax/Cargo tab includes the weight of or the number of cargo and/or boarded passengers.  

Field Description 

Date Date of the flight  

Flight Flight number 

Route Actual route 

 

The next columns may or may not be displayed in your flight log as these are configurable. Some of these records 

may not be needed for tracking by your airline. 

 

Baggage Total weight of baggage for the flight 

Cargo Total weight of cargo for the flight 

Freight Total weight of freight for the flight 

Mail Total weight of mail for the flight 

Dangerous 

Goods 

Total weight of declared dangerous goods for the flight 

Guide Dog Total weight of guide dogs in the flight 

Adult Total number of adult passengers in the flight 

Child Total number of children in the flight 

Female Total number of females in the flight 

Infant Total number of infants in the flight 

Male Total number of males in the flight 
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Creating a Flight Log 

Flight logs can be created only if the flight has the actual arrival time and OOOI times in place. To add a new flight log, 

follow the steps below. 

 
1. Go Tools. Select Flight Logs, then select Manage Flight Logs. 

2. Click Add at the bottom. A blank row with today’s date will appear. 

If you are continuing the flight log of an aircraft that has an existing set of flight logs, search for the flight log and 

expand it. Proceed to step 4. 

3. Select the registration/tail number. Expand the row by clicking on the [+] at the leftmost column. 

 
 

4. Click Add inside the flight log. Select one flight or select multiple flights using the Ctrl+click action. Click the Add 

Selected button. 

 
 

5. The flight/s will be added to the flight log. Review the times of the flight and modify any of the details as needed. 

Refer to the FlightInfo section for more information. Click Save under the flight. 

 
 

6. Go through each tab and modify the information as needed. All changes made in the tabs will be reflected in the 

Grid, Gantt and FIW. Refer to Flight Log Contents for more information on each tab. Click the Save button under 

the flight. 

7. When all flights are accounted for, click the Sign Off button to finalize the changes. Once this is done, users can 

no longer modify information on the flights. 

Things to note when working on flight logs: 

 

• The Log No is a free text field that must be added by users. It is recommended to have a formatting convention 

when using this. 



2016 | COMMERCIAL IN CONFIDENCE | Page: 79 of 121 

• One or more flights can be added to a flight log. It is up to the airline’s process if there should be one flight log 

per aircraft per day, or one flight log per set of crew per day, etc.  

• Flight log entries can be validated based on the data entered by users and this is controlled by several user 

preferences found in Configure: 

o Validation of flight times and fuel values is controlled by the user preference 

ValidateFightTimesAndFuelValues. This ensures that the times entered are in chronological order (OFF 

time comes before IN time, for instance). 

o To properly handle the difference in fuel levels before departure and after arrival, the user preference 

MissingFuelUpliftValidationThresholdPercent is set to 20% by default. This means that there can be a 

20% difference between the actual uplift value and entered value.  

• The user must sign off on the flight log. Otherwise, users can still modify the details, which can affect the results 

of audits. 

Automated Flight Logs 

For customers that do not manually enter flight logs to monitor pilots’ take-offs and landings, the 

UpdateFlightLogEmployeeFlyingJob can be used. When activated, the job will assume that the flights assigned on future 

days will be considered as operated and the take-off and/or landing will be considered in the rule. For the past flights, the 

take-off and landing will be automatically considered in the rule.  

 

In the example below, the crewmember was offline for more than 90 days and will return to work on the 1st of May. He is 

rostered for two training flights per day for the first few days of his roster. Let’s say that the current day is the 25 th of April. 

With the snapshot of the roster below, the results of the Flight Currency Rule validation are displayed below the roster.  

 

The rule requires 3 landings and take-offs (LTOs) in 90 days for any equipment type. 

 

 
 

On the 1st, 2nd, 3rd and 5th of May, he has two flights on each pairing. On the 4th of May is an unavailable day. 

 

The job counts the number of operating flights in the future and assumes that the crewmember will report for work and 

operate those flights. The LTO count for those flights is temporarily counted and the is given to the RulesEngine. When 

validating the roster for future days, the rule considers the temporary count and the appropriate violations are displayed in 

the Monitoring Panel.  

 

The violation for the 1st of May says that that the 3 LTOs have not been achieved. This was raised because he only has 

two flights for that day. 

 

The violation message for the 2nd of May says that the 3 LTOs have been achieved. The two flights on the previous day 

and the first flight for that day satisfied the rule. This follows on even for the 3rd and 5th of May.  
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If all goes well with the roster and the crewmember shows up for all his duties on those days, the 

UpdateFlightLogEmployeeFlyingJob will record 1 LTO for each flight that he operated as a student. This has the same 

effect as a user creating a flight log for each of the flights and recording the LTO.  

 

If the crewmember called in sick on the 1st of May, the violation against the rule would be on the 2nd of May and the violation 

message for passing the rule would be on the 3rd and 5th. 

 

Once a day, the UpdateFlightLogEmployeeFlyingJob assesses the flights from the previous day and logs the LTOs for all 

pilots. These are the actual LTO counts and are no longer temporary. The rule uses both the actual and temporary counts 

depending on the validation period. 

 

The job allots the actual count by rank – pilot-in-command (PIC), captain and then first officer. 

 

For a 2-pilot operation and a duty has four flights, the first flight is credited to the captain, then the second flight to the first 

officer, then the third flight to the captain and the fourth flight to the first officer. 

 

If there are more than 2 pilots, the PIC is credited first then the captain, then the first officer. 

 

Manage Simulator Logs 

Simulator (SIM) courses can be recorded as a takeoff and landing and can be included in the crew’s currency. This is 

usually done when a crew who was inactive for a few months comes back online and trains in a SIM to update his currency 

before he can legally operate a flight. 

To add a simulator log, follow the steps below: 

1. Go to Tools and select Flight Logs. Select Manage Simulator Logs. 

2. The form is like the Flight Log form. Click Add at the bottom of the form. 

3. Add the Date in the first row and enter a log number under the Log No column. 
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4. Click Add within the SIM log. 

 
 

5. Search for the SIM course by filtering for the date. The list includes SIM courses created in CrewPlan and SIM 

pairings assigned to crew. 

6. Select the SIM and click Add Selected. 

7. Fill out the flying type and approach type for the SIM, as well as the takeoff and landing for the crew. 

 
 

8. Click Save. If the records are final, click SignOff. 
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Menu Options 

File Menu  

The Flight menu contains options on managing the flight display. 

 

 

Open Flight Display 

The Open Flight Display function opens the Filter Panel and the Flight Display Panel. 

 

Save Flight Display  

The Save Flight Display feature saves the information modified in the Grid and Gantt views. This works the same as clicking 

the Save Flight Display Entries button ( ). 

 

Print Flight Display 

The Print Flight Display feature prints flight information from the Flight Display Panel. This works the same as clicking the 

Print button ( ). 

 

Delete Flight Display 

This feature will be available in the future. 
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Reset Layout 

The Reset Layout function resets the AircraftFollow default display, which has the Filter Panel on the left side and the Flight 

Display Panel on the right. This function is a quick way to restore default settings after moving panels around. The reset 

function does not clear filter or panel data.  

 

Close Flight Display 

The Close Flight Display feature closes the Filter Panel and the Flight Display Panel. Only the toolbar remains on the 

screen.    

 

If you have unsaved data in the display, the following message will display: 

 

 
 

Click OK to proceed and lose unsaved data or click Cancel to close the form without generating action. 

Edit Menu 

The Edit menu provides some options similar to the toolbar. 

 

Add New Flight 

This option brings out a new row at the bottom of the Grid view where users can enter the details of the new flight. This 

works the same as the Add Flight button ( ). 

 

Flight Information 

This option brings out the Flight Information Window of the selected flight. This works the same as the FIW button ( ). 

 

View Menu  

The View menu provides several options for modifying the display of flights and for isolating some information. 

 

Time Mode 

To change time modes, select Time Mode and select one of the options below: 
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• Zulu (Z): Zulu time is known as Greenwich Mean Time (GMT) 

• Port (L):  Port time is local time in your time zone   

• Standard (S): Standard time is local time at your company headquarters 

The selected time mode is displayed at the top of the Gantt. 

 

 
 

It is also displayed beside the flight times. 

 

 
 

Use Tail Number/Use Registration 

The terms Rego/Registration and Tail Number can be interchanged in the system. Both refer to the unique identification of 

an aircraft.  

 

If your airline currently uses registrations, the option in the View menu is Use Tail Number. Once selected, the column 

header in the Grid will be changed to Tail Number. 

 

 
 

If your airline currently uses tail numbers, the option in the View menu is Use Registration. Once selected, the column 

header in the Grid will be changed to Rego. 

 

 
 

View Cancelled and Deleted Flights in the Gantt Chart 

This feature is part of future development. 

 

PlayPen 

This feature is part of future development. 

 

Flight Information 

This feature is part of future development. Alternatively, flight information can be also be accessed from the toolbar and 

from double clicking the flight in the Grid and Gantt view. 

Crew Flows  

This feature is part of future development. 
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Crew Complement  

This feature is part of future development. 

Application Log  

This feature is part of future development. 

Flight Conflict  

The Flight Conflicts form was designed to display a summary of turnaround time issues, port mismatches and other 

violations. The full feature is part of future development.  

Port Requirement   

This feature is part of future development. Alternatively, this feature can be accessed through links in the Flight Information 

Window. 

Route Requirement   

This feature is part of future development. Alternatively, this feature can be accessed through links in the Flight Information 

Window. 

Gantt Chart   

This feature is part of future development. Alternatively, the Gantt view of the Flight Display Panel is readily available to 

system users. 

View Flight Status  

This feature is part of future development. Alternatively, this feature can be accessed through links in the Flight Information 

Window. 

View Delay Minutes Breakdown  

This option displays the delay information of the selected flight without going through the Flight Information Window. 
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Gantt-Chart Display 

This feature is part of future development. Alternatively, the Gantt view of the Flight Display Panel is readily available to 

system users. 

Expand Cycles  

This option expands all the cycles in the Gantt view, similar to clicking the Expand Cycles link at the top right corner of 

the Gantt.   

Collapse Cycles  

This option collapses all the cycles in the Gantt view, similar to clicking the Collapse Cycles link at the top right corner of 

the Gantt. 

Tools Menu 

The Tools menu contains options that allow users to manage more information that affect flights. 

Run Rules  

This feature is part of future development. 

Manage MEL 

 
 

A Minimum Equipment List (MEL) is a record of a registered maintenance issue associated with a specific aircraft 

registration. A MEL applies to an aircraft for a pre-determined period. When viewing MELs for a registration, only current 

MELs or MELs that are active on the selected date range will display. 

 

A MEL is applied to an aircraft by Engineering when an aircraft has a technical issue but can still operate under certain 

minimum conditions. This MEL may mean the flight cannot fly to certain airports. 
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Find MEL 

 

 

To find a MEL using the search function in the Manage MEL form: 

 

1. Select applicable Operator, Equipment Type and Equipment Rego (Registration) from the dropdown menus. 

2. Select the Start Date and Predicted Resolution Date from the dropdown calendars. 

3. Select the Show Opened checkbox to view open MELs. 

4. Click Find to generate a list of current active MELs.  

 

A list of aircraft MELs will display on the lower part of the form. The date column headings enable you to filter 

the date range of MELs to view. The list will state if a MEL is open or closed. Once the applicable MEL is 

located, it may be edited or closed. 

 

5. If no further action is required, click Close MEL to cancel to close the form without generating action. 

 

Note: Only current MELs or MELs active in the selected date range open in the Flight Information Panels will be 

displayed.   

 

Add MEL 

 

To add a new MEL from the Manage MEL form: 

 

1. Click Add. 
2. Complete the required fields on the MEL Item Template (red link at the upper right corner). 

The minimum required fields are marked with an asterisk  
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Field Description 

Saved MEL Click the down arrow to access a drop-down menu of pre-saved MELs, if applicable 

Equipment Type Select equipment type from the list of equipment types in the dropdown list 

Equipment Rego Select applicable aircraft registration from the list of registrations in the dropdown list 

Start Date Select a start date for the MEL using the dropdown calendar  

Predicated 
Resolution Date 

Select a predicted resolution (end) date using the dropdown calendar  

Start Time Enter start time in hh:mm format 

End Time Enter end time in hh:mm format 

Expiry Date User selects an expiry (expiration) date for the MEL using the dropdown calendar  

Expiry Time User selects an expiry time for the MEL, in hh:mm format 

Max Hours Enter maximum hour value  

Max Cycles Enter maximum cycles 

Current Hours Informational only. It displays current hours on aircraft at the time the MEL is being 
entered 

Current Cycles Informational only. It displays current cycles on aircraft at the time the MEL is being 
entered 

Title User entered text field to provide a title for the MEL 

Criticality Level Select Allow Override, Critical or Critical Planning using the dropdown list 

Duration Auto calculated from start and expiry times, displayed in days, hours, minutes format 

Port Restriction Select the check box to search for or enter manually any port restrictions. Restrictions 
and ports will also auto-complete if typed manually in the control field.   

Route Restriction Select the check box to search for or enter manually any route restrictions. 
Restrictions and routes will also auto-complete if typed manually in the control field.   

Comments User entered text field for MEL related comments 

  
3. Click Save MEL to save the event or Cancel to close the form without generating action.  

Once a MEL has been entered against an aircraft registration, a MEL icon appears in the Gantt chart and the grid 

view of the Flight Display Panel against that registration as long as the open schedule contains a MEL within its 

period. 

 



2016 | COMMERCIAL IN CONFIDENCE | Page: 89 of 121 

Note: If the MEL has a restriction against it and the aircraft operation breaks one of the port, route, hours and/or cycles 

restrictions this will be displayed once the MEL has been saved.  The same thing applies if there are any disruptions that 

change the schedule so that it breaks a restriction. The level of the criticality will depend on what was selected. 

 

Edit MEL  

 

To edit an existing MEL from the Manage Mel form: 

 

1. Select the desired MEL in the grid, by clicking on the row  

 

 
 

 

2. Click Edit MEL at the bottom of the MEL form (shown above) 
 

 
 

3. The system will open the Edit MEL form for the user to edit the details. 

4. Edit the MEL as needed 

5. Click Save MEL to save the changes.  
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Close MEL  

 

To close an existing MEL from the Manage MEL form: 

 

1. Select the desired MEL in the grid.  

2. Click Close MEL at the bottom of the MEL form. 
 

The application will prompt the user for comments. 

 

 
 

3. Click Save to save the comments, then Cancel to the Manage MEL form. 
 

The system closes the MEL recording the comments, date/time of closure and your name. 

Manage Maintenance 

Manage Maintenance allows users to align aircrafts with their flights and maintenance events. Go to the Maintenance 

Events section for more information. 

Auto Allocate-Rego  

This tool makes it easier to assign several flights to an aircraft based on the number of flights or hours with consideration 

for maintenance events.  
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You can auto allocate flights using the following steps:   

 

1. Select hourly increment to search for unallocated registrations using the up and down arrows. 

2. Click on Fetch to retrieve list of unallocated registrations 

Unallocated registrations will display in the grid. 

3. Select the Number of Flights or Number of hours radio button. 

4. Select the Yes radio button to Allocate to Subsequent flight/s. 

5. Click OK to allocate or click the Cancel button to close the form without generating action  

 
Alternatively, users can search for unavailable regos (registrations) using the following steps:  

 

Halfway down the form, select hourly increment to search for unavailable registrations using the up and down arrows, 

 

1. Click Add to retrieve list of unavailable registrations. 

 

Unavailable registrations will display in the grid area. 

 Unavailable registrations will be displayed, for example, due to a maintenance event. 

  

2. Click on OK to allocate or click Cancel to close the form without generating action.  

Route  

The Route form allows users to manage routes maintained in the system. This is the same form used by administrators in 

Configure. This requires security rights to be granted to the user before it can be made available. 

 

This is handy to have when a flight is diverted to a port and this new route is not yet in place in the system. 

 

 
 

Find Route 

 

To search for a route: 

 

1. Enter the Route name (no dash or hyphen) and select the Route Type from the drop-down menu. 

2. Select the Show Active check box to display active routes. 

 

View the corresponding routes from the designated departure airport in the grid below  
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Alternatively, select a letter corresponding with the name of the departure airport from the A-Z alphabet, or select All and 

view the corresponding routes in the grid.  

 

Click Cancel to close the form. 

 

Add Route 

 

To add a route using the Route form: 

 

1. Click Add at the bottom of the Route form. 

A new row is inserted at the bottom of the grid  

 

2. Enter the following fields: 

 

Field Description 

Route  Enter from and to ports, for example HAVCMW 

Departure Port The departure port will automatically populate with the name of the airport 

Arrival Port The arrival port will automatically populate with the name of the airport 

Route Type Select the route from the dropdown menu 

Primary Primary check box, leave as unchecked  

Active Select the Active check box if this is an active route 

 

3. Click Save to save the added route or Cancel to close the form without generating action.       
 

Delete Route 

 
To delete a route, locate the route for deletion. Click on the row for deletion and click Delete. 

 

A delete dialog box will ask you to confirm the deletion. Click on the Yes button to delete or the No button to close the 

dialog box without generating action. 

Options 

The Options menu allows users access to some of the flight-related configuration that administrators have access to in 

Configure. 

 

Delay/Cancellation Code Group 

 

The Delay Code Group form displays categories of delay codes and corresponding descriptions as specified by the 

International Air Transport Association (IATA). For example, Operations and Crew Delays are code 60 delays. Code 60 

related delay codes are assigned based on the circumstances which caused the delay. 

 

When the Show Active check box is selected, only active delay codes will be displayed. 



2016 | COMMERCIAL IN CONFIDENCE | Page: 93 of 121 

 

 
 

Delay Code 

 

The Delay Code form enables the user to view specific delay codes within a delay code group. In the example shown 

below, delay codes for Operations and Crew Delays, known as code 60 delays are itemized.   

 

 
 

The steps to view a specific delay code group are as follows:   

 

1. Select the appropriate Delay Code Group from the dropdown menu. 
2. Select the Show Active check box. 

 

The delay code numbers are listed in the Code column. The IATA Code column holds the default IATA code of the 

corresponding delay code, if a different scheme is used for the Code column. The delay code description in the 

corresponding Description column. The Passenger Information column communicates the reason for the delay to 

customers, based on text entered into the Passenger Info field by the system user. The Active column indicates that the 

delay code is an active delay code. 

 

To add a delay code: 

 

1. Click Add to add a new delay code. 
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2. Type the delay code number and tab to the delay code description and passenger information fields to enter 

text, then select the Active check box. 

3. Click Save to save the delay code or Cancel to close the form without generating action. 

 

To delete a delay code: 

 

1. Click to highlight the row containing the delay code for deletion. 

2. Click Delete to delete the delay code. 

 

 
 

3. Click Yes to confirm deletion of the delay code or the No button to close the dialog box without generating 

action 

4. Click Save to save the changes, the delay code will no longer show on the delay code list. 
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Flight Follow Time Code 
 
The Flight Follow Time form allows users to add and delete values for notable flight times such as in to gate, wheels up, 
wheels down, out from gate and taxi time. These columns will appear in the flight log.   

 

 
 

To add a time code using the Flight Follow Time Code form: 

 

1. Click Add at the bottom of the Flight Follow Time Code form. 

A new row is inserted at the bottom of the grid  

 

2. Enter the following fields: 

 

Field Description 

Code Text to use as the column header in flight logs. Shortcut or abbreviation of the Name 

Name Name of the field 

Mandatory Select the checkbox if this is a mandatory field 

EntryMask Required format for the entries. For time, use hh:mm. For counting numbers, use nn. 

Display Order Column order for display in flight logs 

Time Sequence Chronological order for validating time entries 

Valid From Code validity date start 

Valid To Code validity date end 

Active Select the check box, if this is an active code 

 

3. Click Save to save the added route, or Cancel to close the form without generating action 
 

 

To delete a time code using the Flight Follow Time Code form: 

 

1. Click on the time code row for deletion. 

2. Click Delete. 

A prompt asking, “Are you sure you want to delete the specified item?” will appear. 

3. Click Yes to delete, or Cancel to close the form without generating action 
  



2016 | COMMERCIAL IN CONFIDENCE | Page: 96 of 121 

Flight Follow Status Code 
 

The Flight Follow Status Code enables users to communicate flight status to designated parties.  

 

Values entered into this form can be transferred to FIDS screens via the merlot.aero web service.  

 

 
 

The Flight Follow Status Code form transmits flight status information, using standardized codes into messages for selected 

audiences, which may include passengers and operations in the form of FIDS, email messages and text messages.    

 

System users can add/or delete status code fields from the form to meet operational needs. 

 

To add a status code using the Flight Follow Time Status form: 

 

1. Click Add at the bottom of the Flight Follow Status Code form. 

A new row is inserted at the bottom of the grid.  

 

2. Enter the following fields: 

 

Field Description 

Code Text to use as the code for this status. Shortcut or abbreviation of the Name 

Name Name of the status 

Pax Message Select the checkbox to include this status when sending information to FIDS screens for 

passengers 

Ops Message Select the checkbox to include this status when sending information to FIDS screens for 

operations personnel 

Email Select the checkbox to include this status when sending flight statuses via email 

Text Select the checkbox to include this status when sending flight statuses via SMS 

Active Select the check box if this is an active status code 

 

3. Click Save to save the added code, or Cancel to close the form without generating action 
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It is recommended that the system user deactivate status codes rather than delete them. To deactivate a status code, 

uncheck the Active check box and click Save. 

 

Flight Follow Counter Code  
 

The Flight Follow Counter Code form allows users to view as well as add and delete codes for fields such as baggage, 

cargo, freight, mail, other and passengers. System users can then enter passenger, baggage, mail, and cargo counts into 

the Flight Follow Counter Group form and have the data transmitted to load control, if required, for weight and balance 

purposes. 

 

 
 

The existing counter code fields displayed above are editable and new fields/codes can be created based on station 

requirements.  

 

To add a counter code using the Flight Follow Counter Code form: 

 

1. Click Add. 

2. Enter the following fields: 

 

Field Description 

Code Text to use as the code for this entry. Shortcut or abbreviation of the Name 

Name Name of the item to be counted 

Use in WB 

Payload 

Optional: Select the check box if the counter code should be used in weight and balance payload 

calculations.    

WB Payload 

Display Order 

Optional: Select the check box if the counter code should be displayed on the weight and balance 

display order 

Use in WB Pax Optional: Select the check box if the counter codes for passenger weights should be used for 

weight and balance  

WB Pax Display 

Order 

Optional: Select the check box if the counter codes for passenger weights should be used for on 

weight and balance display order 

Active Select the check box if the code is an active status code 

3. Click Save to save the added code, or Cancel to close the form without generating action 

 

Note: The weight and balance columns are optional at this time. These columns will be used in merlot.aero’s weight and 

balance mobile app. 

 

The delete function works the same as in other forms in AircraftFollow. Select the item to be deleted, click Delete, and 

click Yes to delete the specified item, after verifying the correct item for deletion. It is recommended that the system user 
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deactivate status codes rather than delete them. To deactivate a status code, uncheck the Active check box and click 

Save. 

 

Flight Follow Configuration  
 

Flight Follow Configuration allows airlines to create delay and OTP configuration for certain groups of flight determined by 

the flight number range. Please consult the Configure User Manual for information about configuring delays and on time 

performance settings. 

 

 
 

Freight Breakdown 

 

The Freight Breakdown feature in the Tools menu is part of future development in AircraftFollow. 

Cargo Breakdown 

 

The Freight Breakdown feature in the Tools menu is part of future development in AircraftFollow. 
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User Preference   
 

The User Preference form allows system administrators to set up visual preferences in AircraftFollow based on individual 

airline specifications. For instance, flight status colors can be modified according to preference as well as date formatting, 

time mode and field positions in the Flight Display Panel. 

 

 
 

User preference editing is restricted to administrator access. To edit preferences, click a row to select the row, modify the 

value as needed and click Save to save changes or Cancel to close the form without generating action. Click Reset to 

return the user preferences to the default state. This subject is discussed in detail in the Configure User Manual. 

Find 

The Find tool enables users to search for flights in the Grid and Gantt views. The keyboard shortcut for this is <Ctrl + F>.  

 

The Ctrl+F option brings out the simple search tool. To use this, enter the flight number and click Find. The flight will be 

highlighted in the Grid and Gantt views. Click Cancel to close the form. 

 

 
 

If the user clicks Detailed Search, the complete Search Criteria form displays. This is the same form accessed from the 

Tools menu. 
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To find a flight/aircraft, fill out the Search Criteria fields as follows: 

 

Field Description 

Pre-Saved 

Search  

Click the down arrow to access a dropdown list of previously saved flight searches, if applicable 

Equipment Type Enter the equipment type or model 

Flight Designator Select the flight designator from dropdown list 

Equipment Rego Enter the equipment registration or tail number and a list will generate. Choose the applicable 

rego. 

Departure Port Enter the departure airport and a list will generate. Choose the applicable airport. 

Arrival Port Enter arrival airport and a list will generate. Choose the applicable airport. 

STD Enter the schedule time of departure using the up/down arrows 

Flight Label Enter flight label 

Client Reference Enter client name, if applicable 

Time Margin Enter additional time range (X hours before, X hours after) for search 

 

Click the Search button to initiate the search, results will be displayed under Search Results in the form, or click Cancel 

to clear the form. 

 

Other search button related options include: 

 

Field Description 

Save Search Click the Save Search button to save search criteria for future use 

Set Default Search Click the Set Default Search button to save the search as the default search criteria 

every time this form is opened 

Delete Saved Search Click the Delete Saved Search button to delete the saved search from the pre-saved 

search menu 

Display in Flight Entry Click the Display in Flight Entry button to display search results in the Grid view 

 

The buttons located at the bottom of the Search Criteria form assist users in targeting flights that are part of irregular 

operations. 

 

 
 

Search result data can be analyzed in more detail by using the following irregular flight search features:  
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Field Description 

View All Disrupt Flights Click the View All Disrupt Flights button to view all disrupted flights, similar to the 

Filter Panel 

View Diverted Flights Click the View Diverted Flights button to view diverted flights 

View Delayed Flights Click the View Delayed Flights button to view delayed flights 

View Deleted Flights Click the View Deleted Flights button to view deleted flights 

View Cancelled Flights Click the View Cancelled Flights button to view cancelled flights 

 

Quick Cycle Swap 

Quick Cycle Swap allows you to swap multiple flights that are associated against a registration. It is a time-saving feature 

that enables users to swap multiple flights quickly and maintain the line of flight, rather than making changes manually in 

the Gantt. 

 

 
 

1. Click the Add button to add a new row under the registration and current allocation column. 

2. Select a registration from the dropdown list under the Registration column. 

3. Select the current allocation from the dropdown list under the Current Allocation column. 

4. Select from the New Allocation column the flights you now want on the registration (see step 2). 

5. Click Commit to assign the new allocations to the selected registration. 

 

Orphaned sectors are those flights that are not assigned to an aircraft. Some of them could have been originally 

assigned to an aircraft but got unassigned because of a flight disruption and the rest of the flights were put in a new 

cycle without a registration. 

 

You can add orphaned flights by selecting them from the list found under the heading Orphaned Sectors to the new 

allocation. 
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Generate APIS UNEDIFACT 

This form is used to manually send crew information via APIS messages to a country’s border control authority.    

 

 
 
The steps to complete the APIS UNEDIFACT form are as follows: 

1. Select the Operator, Date and Flight number from the respective dropdown lists. 

2. Select the From and To airports (departure and arrival, respectively) from the dropdown lists. 

3. Enter the UNEDIFACT Format/Address 

4. Select the radio button for Initial Message or Update Message, as it applies. 
5. Click Send to send UNEDIFACT data or click Cancel to close the form without generating a message. 

The Show button displays the message content in the message window and the message can be copied by 
clicking Copy, and then paste it on an email template. 

The default setting when generating an updated APIS UNEDIFACT message only includes the names of the crew who 

were added to a flight during duty changes. To include all the names of the operating crew in the updated message, change 

the default setting of the subscription parameter FCMIncludeAllEmployeesOnDutyChange in Configure. 

 

Note: For crew members entering mainland China, users have the option to include Chinese names by configuring the 

IncludeName2 and IncludeName3 subscription parameters for Export.UnEdifactFcmExportJob and 

Export.UnEdifactMclExportJob when generating APIS UNEDIFACT messages. 
 

Flight Logs 

Flight logs are the official records of a flight. This option has three more options within: 

 

• Manage Flight Logs – go to the Flight Logs section for more information. 

• Export Flight Logs – transmits flight log information to a third-party system. 

• Manage Simulator Logs – go to the Manage Simulator Logs section. 
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Reports  

To view Reports within AircraftFollow, select the Reports tab and choose a report. 

 

These reports can be customized to meet specific customer requirements. It is suggested that systems users review the 

existing list of reports to assess applicability for the airline. 

4001-Fuel Log Report 

 

Aircraft Allocation Report 
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Aircraft Flows Report 

 

Aircraft Operational Detail Report 

 

City Pair Analysis Report 
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Colombo Customs Report 

 

Daily Movement Sheet Report 

 

Delay Break-up Report 
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Delay Details Report 

 

Delay Report 

 

Executive OTP Summary Report 
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Flight Cancellation Report 

 

Fuel Log Report 

 

Fuel Up-lift Detailed Report 
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General Declaration Report - ICAO 

 

 
 

merlot.aero’s General Declaration Report follows the ICAO standard. However, some countries require different details 

that deviate from it. The filter criteria allow certain details like changing the designator and displaying the employee code 

and passport issue date.  

 

For Taiwanese and Hong Kong passport holders entering China, a different document is required and its details must be 

included in the report. The document types needed are Mainland Travel Document (China) for Taiwan and Home Re-entry 

Permit (China) for Hong Kong. The applicable document must be entered for the employee. Also, all ports in China must 

have either documented selected in the Immigration tab of the port. 
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General Declaration Report – CBP 
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Indian Crew Baggage Declaration Report 

 
 

Indian Temporary Crew Landing Permit Report 
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Landing Charges Report 

 
 

On-time Performance Report 

 

OTP Summary Report 
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OTT Report 

 
 

OTT Report (SRS) 

 
 

Schedule Report  

This report is for future development. 

Schedule Summary Report  

This report is for future development. 
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Scheduled vs. Actual Report 

 

Sector Analysis Report 
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Total Movement Report 

 

Voyage Report 
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Application Flow Diagram 

  

 

Configure application is a central place where all crew and aircraft configuration information can be 

accessed. The application defines the core set of configuration requirements that are the building 

blocks that allow merlot applications to be used in the way required by your airline. 

AircraftSchedule improves the development of flight schedules while ensuring operational integrity 

and meeting the needs of airlines for increased efficiency in scheduling. The application includes a 

maintenance planning capability. 

CrewBuild develops efficient crew pairings that achieve business goals while meeting the needs of 

crew and managing changes that arise after the roster is published. 

CrewPlan plans and monitors all revalidation and qualification checks, medicals, license renewals, 

annual leave and administrative needs. Crew shortfalls or surplus information is accurately 

calculated by fleet, rank or base and can be aggregated at daily, weekly or monthly levels. This 

extends to future establishment planning. 

The CrewRoster application allows the user to develop efficient crew rosters that achieve business 

goals while meeting the needs of crew.  

CrewFollow provides airlines with the best information to act on in response to crew disruptions 

resulting from (amongst other things) sickness, no-shows and crew-related disruptions on the day. 

CrewMonitor identifies and monitors changes within merlot for disruptions that will impact pairings 

and pairing allocations to crew members. 

CrewPortal and CrewMobile provide airline crew with the ability to view the latest crew related 

information on a computer or mobile device such as phones or tablets. It enables airline operations 

employees to securely distribute timely and relevant information to crew members including duty 

assignments, duty changes and messages. 

AircraftFollow provides a real time graphical representation of your airline’s live status for the day. 

AircraftFollow allows the user to manage incoming and outgoing aircraft and related operational 

tasks on a day-to-day basis. The application provides accurate and timely information to improve 

the decision support process. 

AircraftPortal and AircraftMobile provide outstations with the ability to view the latest schedules and 

fight-related information on a computer or mobile device. Updates to departure and arrival times, 

terminals, gates and bays can be done from here. These also allow management a quick look at 

the day’s operations. 

 

CrewPayroll manages complex pay and allowance calculations for crew. 

The ExecutiveDashboard provides executive level reporting including key performance indicator 

(KPI) data to help airlines gauge operational and employee success.  

Configure 

AircraftSchedule 

 

CrewBuild 

 

CrewPlan 

CrewRoster 

CrewFollow  

 

CrewMonitor 

CrewPortal, 
CrewMobile 

AircraftFollow 

AircraftPortal, 
AircraftMobile 

CrewPayroll 

ExecutiveDashboard 
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AircraftFollow Glossary  

Term Definition 

ACARS Aircraft Communications Addressing and Reporting System. A digital data link system for 
transmission of short messages between aircraft and ground stations via air band radio or satellite. 

Air Return An event where the aircraft takes off from a port and makes an unscheduled return to the same 
port 

AOC Air Operator's Certificate. Also referred to as Operator or Operator Code. The AOC is the approval 
granted by a national aviation authority (NAA) to an aircraft operator to allow it to use aircraft for 
commercial purposes. This requires the operator to have personnel, assets and system in place to 
ensure the safety of its employees and the public. 

APIS Advance Passenger Information System. An electronic data interchange system established by 
U.S. Customs and Border Protection (CBP). APIS governs the provision of a limited number of data 
elements (identification details from the passport and basic flight information) from commercial 
airline and vessel operators to the computer system of the destination state. Required information 
should conform to specifications for UN/EDIFACT Passenger List Message (PAXLST) formats. 

Arrival Time The time the aircraft arrives at the specified port. There are three sets of arrival times used in the 
system: 

• Scheduled time of arrival (STA) - the original arrival time 

• Estimated time of arrival (ETA) - the expected time of arrival. This can change 
depending on the performance of the previous flights. 

• Actual time of arrival (ATA) - the exact time the aircraft stops 

ATC Air Traffic Control. A service provided by ground-based controllers who direct aircraft on the ground 
and through controlled airspace, and can provide advisory services to aircraft in non-controlled 
airspace. The primary purpose of ATC worldwide is to prevent collisions, organize and expedite 
the flow of traffic, and provide information and other support for pilots. 

Available 
Seat Miles 
(ASMs) or 
Available 
Seat 
Kilometers 
(ASKs) 

A common industry measurement of airline output that refers to one aircraft seat flown one 

mile/kilometer, whether occupied or not. An aircraft with 100 passenger seats, flown a distance of 

100 miles, generates 10,000 available seat miles. 

ASM Ad hoc Schedule Message. A message containing flight schedule information. This can be 
imported and exported by the JobEngine. 

Block Hour Also called block time, blocks or flight hours. The time from the moment the aircraft door closes at 
departure of a flight until the moment the aircraft door opens at the arrival gate following its landing. 
Block hours are the industry standard measure of aircraft utilization (see above). Many airlines 
consider a block hour to be from the time the chocks are removed from the wheels of a departing 
aircraft, after doors have been closed, until the time the chocks are put in place at the wheels after 
arrival at the airport gate before the doors are opened. 

Cargo Goods carried by the airline not associated to a passenger. 

Company 
Time 

This refers to the time at which the pairing or event is occurring converted to the company’s base 

or headquarters location. 

Covered 
Sector 

A flight that has been assigned to a pairing. 
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Crew A specific type of employee required for flight operations. This term is interchangeable with 

employee. 

Crew 
Complement 

The number and types of crew required for a pairing. 

Crew Flow The sequence of flights and events contained within a crew's duty. This may or may not be aligned 

to aircraft sequence. 

Day of 
Operation 

The day of the schedule that is today. 

Delay Deviation between the scheduled time of departure/arrival and the actual time of departure/arrival 

Department The areas within an airline or company that are tasked with providing particular services of a similar 

type. For example, in an airline there are Flight Operations (i.e. the manning and operating of 

aircraft), Maintenance (ensure the aircraft were able to operate safely), and Ramp (the parking and 

coordination of aircraft resupply between flights). 

Departure 
Time 

The time the aircraft departs from the specified port. There are three sets of arrival times used in 
the system: 

• Scheduled time of departure (STD) - the original departure time 

• Estimated time of departure (ETD) - the expected time of departure. This can change 
depending on the performance of the previous flights. 

• Actual time of departure (ATD) - the exact time the aircraft stops 

Designator Unique alphanumeric code given to distinguish each airline, or operations within an airline. 

Dispatcher The dispatcher is the person responsible for producing a flight plan with the best routing. They 
monitor the weather situation and are there to report non-forecast conditions to the flight crew via 
a radio uplink. The dispatcher has access to on-staff meteorologists, mechanics, air traffic control 
centers and operations centers around the world. 

Disruptions Operational events that occur on or around the day of operation that result in the need to modify 
pairings that could lead to breaching compliance rules. Disruptions can be manifested as a flight 
delay, diversion, return or cancellation. Some causes of disruption are air traffic, weather and 
technical problems. 

Divert When an aircraft changes its arrival port while in flight, usually due to weather or engineering 
issues. 

Employee The generic term for people who are trained to perform specific tasks/activities. Within Flight 
Operations, the employees are generally referred to as crew or crewmembers; and within 
Maintenance, the employees are generally referred to as engineers, mechanics, avionic 
technicians etc. 

Equip Config Each equipment type can have more than one configuration for seats and cargo. This will affect 
the assignment of flights to aircraft rego/tails. 

Equipment 
Group 

The grouping of a similar set of equipment types. For example, a 737 which could be comprised of 
733 and 734 equipment types. This can also be used as a reference to indicate the equipment 
types that a crewmember is legal to operate on as part of his rating. 

Equipment 
Type 

Also called aircraft type. Model of the aircraft. A specific type of aircraft that has distinct 
characteristics, for example a 733 or 734. This can also be used as a reference to indicate the 
equipment types that a crewmember is legal to operate on as part of his rating. 

Flight Also called sector. The transport taken from a departure point to an arrival point. 
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Flight 
Complement 

The number and types of crew required to operate a flight. 

Flight Display 
Panels 

Displays real-time flight information for flights. It enables airline operations personnel to monitor 

flight operations in real-time and to respond quickly to operational irregularities by making 

necessary adjustments to aircraft and crew. 

Flight 
Information 
Window 
(FIW) 

A popup form giving users access to all information related to a specific flight. Users can also edit 

select flight information via this form. 

Flight 
instance 

A specific flight on a specific date. This term is used for flights that are recurred through a specified 

period. 

Flight Log Also called Voyage Report. Flight logs are the official records of a flight. Details on flight times, 
crew times and fuel logs are included. 

Flight 
sequence 

A series of flights in a chronological flow for one equipment type or an aircraft/tail. 

Flight Status Current state of the flight. Typically categorized as boarding, departed, on time, arrived, delayed, 

diverted, etc. 

Gantt A Gantt chart, commonly used in project management shows you what must be done in terms of 

activities, tasks and events and when in terms of scheduled dates and time. 

Gate The location at the airport where passengers embark and disembark. 

GMT Greenwich Mean Time. Also called Zulu time. The time at location at which the pairing or event is 
occurring converted to Greenwich Mean Time (GMT) value. 

Irregular 
operations 

Also called IROP. Any deviation from the original aircraft schedule is an irregular operation such 
as delays, diversions, air returns, ground returns, cancellations or deletions. 

Join A button in the Pop Up Menu used to join a flight to another cycle. 

Join Onward 

Flights 

A button in the Pop Up Menu used to join a flight, including all the following flights. 

Local Time The time at the location at which the pairing or event is occurring. If the location is the same or in 

the same time zone as the company base or headquarters location this time will be the same as 

the company value. 

Maintenance Also called maintenance event. A servicing event on an aircraft that is scheduled in advance. These 
events typically are scheduled for minutes, hours, days or weeks in duration. 

Maintenance 
Coordinator 

The maintenance coordinator understands all of the aircraft systems and has access to all of the 

maintenance manuals to find a solution to a problem of a technical nature with an aircraft. 

MEL Minimum Equipment List. A record of registered maintenance issues for an aircraft. The list 
determines if the aircraft is airworthy or not. 

Move A button in the Pop Up Menu used to move a flight from one cycle to another. 

MVT Movement Message. A message file containing changes or updates to flight times. 
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NOTAM Notices To Airmen. Issued by the country’s aviation authority to inform pilots of new or changed 
aeronautical facilities, services, procedures, or hazards, temporary or permanent. 

OTP On Time Performance. A measure of how well the airline is performing in terms of following the 
schedule of flights. 

Onward flight A field where users can link one flight to another to form a chronological sequence of flights. The 

onward flight may occur on the following day, but never before the flight’s date. 

Open Sector Also called unpaired flight. A flight that has not been assigned to a pairing. 

Passenger Also called pax. A customer of the airline assigned a seat on the aircraft.  Infants may not be 
assigned a seat. 

Pop Up Menu An intuitive menu that enables users to conveniently move, join, swap and drop flights in the 

Allocation Gantt by dragging a flight puck and holding the mouse on left-click. 

Port An airport or station. 

Puck The graphical representation of a flight or pairing in a Gantt chart. 

Recurrent 
flight 

A flight that operates the same flight number, route and timings on more than one day. 

Replace A button in the Pop Up Menu used to replace a flight with a target flight and drops the target flight 

into a new cycle. 

Replace 

Onward 

Flights 

A button in the Pop Up Menu used to replace a flight with a target flight and drops the target flight 

into a new cycle, including all the following flights on both cycles. 

Rego Also called Registration or Tail Number. Rego is the term for registration in Australia and New 
Zealand. Registration is the unique alphanumeric code given to differentiate each individual aircraft 
from all others worldwide. 

Route A course between two ports, for example BNE-SYD. 

Schedule A timetable of flights. 

Slot A scheduled time when an aircraft can take off and land at a busy airport. 

Split Cycles A button in the Pop Up Menu used to split a cycle into two, starting from the selected flight. 

SSIM Standard Schedule Information Manual. A message file that contains a flight schedule for several 
months. This is commonly used to send a seasonal schedule from one system to another. 

Swap A button in the Pop Up Menu used to swap a flight with a target flight. 

Swap 

Onward 

Flights 

A button in the Pop Up Menu used to swap a flight with a target flight, including all the following 

flights on both cycles. 

Terminal The airport building in which the aircraft will arrive at or depart from. 

Turnaround Also called Actual Turnaround, Scheduled Turnaround, Turnaround Time. Amount of time between 
the arrival of a flight and its departure from a port. This is also the time taken to unload passengers, 
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baggage, cargo, etc. upon arrival and to board passengers and load baggage, cargo, etc. before 
departure. 

Violation 
Behavior 

This determines what can be done to a violation once it is flagged. This works in conjunction with 
violation severity. 

• Inviolate - does not allow the assignment to push through no matter what 

• Override - if the user has the appropriate security rights, he can override the violation 

• Override Disrupt - if the user has the appropriate security rights, he can override the 
violation only if the flight is in disrupt 

• Track - the user can proceed with the roster changes but the violation is retained for 
tracking purposes. The violation will not have a pop up, but will be visible in the Violation 
Panel. 

• Ignore - the violations are retained in the Violation Panel 

Violation 
Override 

This determines how a violation should be overridden 

• Management - the credentials of a management-level user must supply his credentials 
when overriding the violation 

• Supervisor - a supervisor must supply his credentials when overriding the violation 

• Extension - a user with override rights must supply his credentials when overriding the 
violation which consequentially allows an extension to the flight hours, duty hours and/or 
flight duty period 

• Discretion - signifies that the violation will be overridden based on the captain's discretion 

Violation 
Severity 

This determines how a violation is presented 

• Critical - the violation must be addressed. Otherwise, the crew is illegal to fly 

• Ignorable - the violation can be addressed later and will not prevent the crew from    
reporting for a duty 

• Informational - the rule breach is for informational purposes only 

• Passed - the rule is not breached and nothing has to be done 
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Notes  

 
 

 


